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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2018 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
8 S1A48978 12/2018



Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.
NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
10 S1A48978 12/2018



About the Book
At a Glance

Document Scope
PlantStruxure is a Schneider Electric program designed to address the key challenges of many 
different types of users, including plant managers, operations managers, engineers, maintenance 
teams, and operators, by delivering a system that is scalable, flexible, integrated, and 
collaborative.
This document presents one of the PlantStruxure features, using Ethernet as the backbone around 
the Quantum PLC offer and connecting a Quantum local rack to Quantum and Modicon X80 
remote I/O drops and distributed I/O devices. This feature is known as Quantum Ethernet I/O or 
Quantum EIO. (NOTE: Modicon X80 is the generic name given to the M340 I/O modules when 
they are connected remotely to a Quantum controller or module in a PlantStruxure architecture. 
The M340 I/O name is still used when the module is connected to a M340 controller. The product 
references remains unchanged; only the range name changes.)
This guide describes these modules and their roles in a Quantum EIO system:
 140CRP31200: remote I/O head module on a Quantum local rack in a remote I/O main ring
 140CRA31200: remote I/O adapter module in a Quantum remote I/O drop
 BMXCRA312•0: remote I/O adapter module in a Modicon X80 remote I/O drop 
NOTE: The specific configuration settings contained in this guide are for instructional purposes 
only. The settings required for your specific application can be different from the examples 
presented in this guide.
NOTE: The architectures described in this document have been tested and validated in various 
scenarios. If you intend to use architectures different than the ones described in this document, 
test and validate them thoroughly before implementing.

Validity Note
This document is valid for the Quantum EIO system when used with 
EcoStruxure™ Control Expert 14.0 or later.
The technical characteristics of the devices described in the present document also appear online. 
To access the information online:

Step Action
1 Go to the Schneider Electric home page www.schneider-electric.com.
2 In the Search box type the reference of a product or the name of a product range.

 Do not include blank spaces in the reference or product range.
 To get information on grouping similar modules, use asterisks (*).
S1A48978 12/2018 11
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The characteristics that are presented in the present document should be the same as those 
characteristics that appear online. In line with our policy of constant improvement, we may revise 
content over time to improve clarity and accuracy. If you see a difference between the document 
and online information, use the online information as your reference.

Related Documents

3 If you entered a reference, go to the Product Datasheets search results and click on the 
reference that interests you.
If you entered the name of a product range, go to the Product Ranges search results and click 
on the product range that interests you.

4 If more than one reference appears in the Products search results, click on the reference that 
interests you.

5 Depending on the size of your screen, you may need to scroll down to see the data sheet.
6 To save or print a data sheet as a .pdf file, click Download XXX product datasheet.

Step Action

Title of Documentation Reference Number
Quantum EIO, System Planning Guide S1A48959 (English), 

S1A48961 (French), 
S1A48962 (German), 
S1A48964 (Italian), 
S1A48965 (Spanish), 
S1A48966 (Chinese)

Quantum EIO, Distributed Network, Installation and Configuration 
Guide

S1A48986 (English), 
S1A48987 (French), 
S1A48988 (German), 
S1A48990 (Italian), 
S1A48991 (Spanish), 
S1A48992 (Chinese)

Quantum EIO, Control Network, Installation and Configuration Guide S1A48993 (English), 
S1A48994 (French), 
S1A48995 (German), 
S1A48997 (Italian), 
S1A48998 (Spanish), 
S1A48999 (Chinese)

Modicon Quantum Change Configuration on the Fly User Guide S1A48967 (English), 
S1A48968 (French), 
S1A48969 (German), 
S1A48970 (Italian), 
S1A48972 (Spanish), 
S1A48976 (Chinese)
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Quantum using EcoStruxure™ Control Expert, Hot Standby System, 
User Manual

35010533 (English), 
35010534 (French), 
35010535 (German), 
35013993 (Italian), 
35010536 (Spanish), 
35012188 (Chinese)

Modicon X80, BMXNRP0200/0201 Fiber Converter Modules, User 
Guide

EIO0000001108 (English), 
EIO0000001109 (French), 
EIO0000001110 (German), 
EIO0000001111 (Spanish), 
EIO0000001112 (Italian), 
EIO0000001113 (Chinese)

Modicon X80, Analog Input/Output Modules, User Manual 35011978 (English), 
35011979 (German), 
35011980 (French), 
35011981 (Spanish), 
35011982 (Italian), 
35011983 (Chinese)

Modicon X80, Discrete Input/Output Modules, User Manual 35012474 (English), 
35012475 (German), 
35012476 (French), 
35012477 (Spanish), 
35012478 (Italian), 
35012479 (Chinese)

Modicon X80, BMXNOM0200 Serial Link Module, User Manual EIO0000002696 (English), 
EIO0000002697 (French), 
EIO0000002698 (German), 
EIO0000002699 (Italian), 
EIO0000002700 (Spanish), 
EIO0000002701 (Chinese)

Modicon X80, BMXEHC0200 Counting Module, User Manual 35013355 (English), 
35013356 (German), 
35013357 (French), 
35013358 (Spanish), 
35013359 (Italian), 
35013360 (Chinese)

Modicon X80, BMXERT1604T Time Stamp Module, User Guide EIO0000001121 (English), 
EIO0000001122 (French), 
EIO0000001123 (German), 
EIO0000001125 (Italian), 
EIO0000001124 (Spanish), 
EIO0000001126 (Chinese)

Title of Documentation Reference Number
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You can download these technical publications and other technical information from our website 
at https://www.schneider-electric.com/en/download

EcoStruxure™ Control Expert, Program Languages and Structure, 
Reference Manual

35006144 (English), 
35006145 (French), 
35006146 (German), 
35013361 (Italian), 
35006147 (Spanish), 
35013362 (Chinese)

EcoStruxure™ Control Expert, System Bits and Words, Reference 
Manual

EIO0000002135 (English), 
EIO0000002136 (French), 
EIO0000002137 (German), 
EIO0000002138 (Italian), 
EIO0000002139 (Spanish), 
EIO0000002140 (Chinese)

EcoStruxure™ Control Expert, Operating Modes 33003101 (English), 
33003102 (French), 
33003103 (German), 
33003104 (Spanish), 
33003696 (Italian), 
33003697 (Chinese)

Quantum using EcoStruxure™ Control Expert, Hardware Reference 
Manual

35010529 (English), 
35010530 (French), 
35010531 (German), 
35013975 (Italian), 
35010532 (Spanish), 
35012184 (Chinese)

EcoStruxure™ Control Expert, Installation Manual 35014792 (English), 
35014793 (French), 
35014794 (German), 
35014795 (Spanish), 
35014796 (Italian), 
35012191 (Chinese)

Title of Documentation Reference Number
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Characteristics of Ethernet Remote I/O Modules

Chapter 1
Characteristics of Ethernet Remote I/O Modules

Introduction
This chapter describes the head and adapter modules for Ethernet remote I/O communications in 
a Quantum EIO system. Specifically, those modules are:
 140CRP31200: head module on a local Quantum rack
 140CRA31200: adapter module on a Quantum remote I/O drop
 BMXCRA312•0: adapter module on a Modicon X80 remote I/O drop
This chapter includes physical characteristics, port descriptions, and agency specifications for 
these modules.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Quantum EIO 140CRP31200 Head Module Description 16
Quantum EIO Adapter Module Descriptions 19
Module Specifications 22
I/O Devices 24
S1A48978 12/2018 15



Characteristics of Ethernet Remote I/O Modules
Quantum EIO 140CRP31200 Head Module Description

Introduction
The Quantum 140CRP31200 module is the remote I/O head module on the local rack of Quantum 
EIO installations. This module allows the PLC to connect to an Ethernet network and control 
remote I/O devices.

Functionality
The main purpose of the 140CRP31200 module is to provide I/O scanning services of remote I/O 
devices on either a remote I/O network or a device network, which contains remote I/O and 
distributed I/O devices. The module is directly connected to the remote I/O network main ring, and 
it manages the remote I/O network through a daisy chain loop topology. This module also provides 
various Ethernet services, such as configuration for remote I/O devices and diagnostics.
You can use these function blocks with the 140CRP31200 module:
 IU_ERIO (see page 103)
 DROP
 XDROP
Only one 140CRP31200 module can be configured on the local rack. This module has interfaces 
for communicating with Ethernet remote I/O devices on the network.
The 140CRP31200 module allows the PLC to connect to an Ethernet network and to have a 
deterministic I/O exchange with modules in the Ethernet remote I/O drops.
The 140CRP31200 module is dedicated to the management of remote I/O devices only. Other 
services of the 140CRP31200 module:
 The module uses RSTP to enable all remote I/O devices on the main ring to recover from a 

communication disruption within 50 ms.
 The module can configure IP parameters and the configurations for I/O modules on the drops 

for up to 31 remote I/O devices.
 The module provides a communication path (through an interlink) to allow distributed I/O and 

control network traffic to participate on the remote I/O network.
 The module supports Hot Standby functionality. The primary 140CRP31200 module and the 

standby 140CRP31200 module do not swap their IP addresses when a switchover occurs.
16 S1A48978 12/2018



Characteristics of Ethernet Remote I/O Modules
External Features
140CRP31200:

1 LED display
2 SERVICE port (ETH 1)
3 INTERLINK port (ETH 2)
4 DEVICE NETWORK port (ETH 3)
5 DEVICE NETWORK port (ETH 4)

NOTE: To help prevent dust from entering the unused Ethernet ports on this module, cover the port 
with the stopper:
S1A48978 12/2018 17



Characteristics of Ethernet Remote I/O Modules
External Ports
The 140CRP31200 module monitors the functionality of network links depending on which links 
are connected to the network. The module has 4 external ports (but a single IP address):

NOTE: Do not connect a device with a speed in excess of 100 Mbps to any port. If the device is 
configured for a speed that exceeds 100 Mbps, the Ethernet link may not be established between 
the device and the module through the port.

Port Quantity Description
SERVICE 1 The SERVICE port allows the diagnosis of Ethernet ports and provides access 

to external tools and devices (Control Expert, ConneXium Network Manager, 
HMI, etc.). The port supports these modes:
 access port (default): This mode supports Ethernet communications.
 port mirroring: In this mode, data traffic from one or more of the other 3 ports 

is copied to this port. This allows a connected tool to monitor and analyze 
the port traffic.

 disabled

NOTE: 
 You can configure the SERVICE port either on line or off line.
 In port mirroring mode, the SERVICE port acts like a read-only port. That is, 

you cannot access devices (ping, connection to Control Expert, etc.) through 
the SERVICE port.

NOTE: 
The maximum load the network can process from distributed I/O devices is:
 5 Mbps per dual-ring switch (DRS) port or service port
 20 Mbps for distributed I/O traffic on the main ring

Refer to the Service Port Configuration topic (see page 64).
INTERLINK 1 The INTERLINK port provides connectivity to other Quantum EIO modules.
DEVICE 
NETWORK

2 These 2 copper ports provide:
 connections for remote I/O communications
 cable redundancy via the daisy chain loop architecture
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Characteristics of Ethernet Remote I/O Modules
Quantum EIO Adapter Module Descriptions

Introduction
These adapter modules are used on Ethernet remote I/O drops in 31 Quantum EIO installations:
 140CRA31200
 BMXCRA312•0
A remote I/O drop can be connected directly to either the main ring or a remote I/O sub-ring.
NOTE: If you use a low-end CPU (140 CPU 6• 1••) (2 Mb or less), you can only install a maximum 
of 31 remote I/O drops. Of those 31 drops, you can only install a maximum of sixteen 
BMXCRA312•0 remote I/O drops. If you use a high-end CPU (140 CPU 6•• ••) (4 Mb or more), you 
can install a maximum of thirty-one BMXCRA312•0 or 140CRA31200 remote I/O drops.

Functionality
Adapter modules exchange data with the 140CRP31200 remote I/O head module on the local rack:
 The 140CRA31200 module is an adapter module on a Quantum remote I/O drop.
 The BMXCRA31200 and BMXCRA31210 modules are adapter modules on Modicon X80 

remote I/O drops.
Features:
 The input data from the Ethernet remote I/O drop is collected and published to the remote I/O 

scanner.
 The output modules are updated with the data received from the remote I/O scanner.
 The protocol used for exchange is EtherNet/IP.
 The remote I/O scanner views the 140CRA31200 or BMXCRA312•0 module as a remote I/O 

adapter.
 The exchanges are deterministic, which means that the time it takes to resolve a remote I/O 

logic scan is predictable.

CAUTION
Unexpected behavior of the application.
If you use your BMXCRA in a Quantum Ethernet IO architecture, take care to update the 
Quantum CPU and the 140CRP31200 to the following minimum versions:
 CPU: V3.1
 CRP: V1.56
Failure to follow these instructions can result in injury or equipment damage.
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Characteristics of Ethernet Remote I/O Modules
External Features
These adapter modules have the same dimensions and installation constraints as other modules 
in their respective product lines (Quantum or Modicon X80):

1 LED display
2 rotary switches
3 SERVICE port (ETH 1)
4 DEVICE NETWORK port (ETH 2)
5 DEVICE NETWORK port (ETH 3)

NOTE: To help prevent dust from entering the unused Ethernet ports on these adapter modules, 
cover the ports with the stopper:
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Characteristics of Ethernet Remote I/O Modules
External Ports
Two of the Ethernet ports allow implicit I/O exchanges with a remote I/O scanner adapter. (An 
implicit I/O exchange has a maximum frame size of 1400 bytes.) The ports can be implemented 
alone or in redundant mode.
You can use a maximum of 31 adapters in a single Ethernet remote I/O network. For network 
topology planning, refer to the Quantum Ethernet I/O System Planning Guide.
These modules have up to three 10/100 Base-T Ethernet ports:

NOTE: Do not connect a device with a speed in excess of 100 Mbps to any port. If the device is 
configured for a speed that exceeds 100 Mbps, the Ethernet link may not be established between 
the device and the module through the port.

Cable Redundancy
Use a daisy chain network configuration that implements the RSTP service to establish redundant 
communications between the adapter module and a remote I/O scanner. The adapter operates 
normally when at least one of the 2 physical paths to the 140CRP31200 is valid. (For network 
topology planning, refer to the Quantum Ethernet I/O System Planning Guide.)

Port Description
SERVICE The SERVICE port allows the diagnosis of Ethernet ports and provides access to external 

tools and devices (Control Expert, ConneXium Network Manager, HMI, etc.). The port 
supports these modes:
 access port (default): This mode supports Ethernet communications.
 port mirroring: In this mode, data traffic from one of the other 3 ports is copied to this port. 

This allows a connected management tool to monitor and analyze the port traffic.
 disabled

NOTE: 
 You can configure the SERVICE port either on line or off line.
 In port mirroring mode, the SERVICE port acts like a read-only port. That is, you cannot 

access devices (ping, connection to Control Expert, etc.) through the SERVICE port.
 There is no SERVICE port on the BMXCRA31200 adapter module.

Refer to Service Port Configuration (see page 64).
DEVICE 
NETWORK

The DEVICE NETWORK copper port provides:
 connections for remote I/O communications
 cable redundancy
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Characteristics of Ethernet Remote I/O Modules
Module Specifications

Product Certification
The Quantum EIO head/adapter modules meet these standards:

Quantum EIO modules conform to these product certification and marine classification authorities:

The electrical isolation within a Quantum EIO system modules complies with the 
1500 Vac/2250 Vdc 60s from IEEE 802.3 2008.

UL (UL508)
CSA (CSA22.2 no. 142)
C-tick
Hazardous locations (Cl1 div 2)
IEC61000-4-16
EMI EN 55011
CE
EN 61131-1
IEC 61131-2 (zone B and zone C, except surges on AC: zone B only)

Key Certification Body Country
ABS American Bureau of Shipping United States
BV Bureau Veritas France
DNV Det Norske Veritas Norway
GOST Gosudarstvennyy Standart Russia
GL Germanischer Lloyd Germany
LR Lloyd's Register United Kingdom
RINA Registro Italiano Navale Italy
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Characteristics of Ethernet Remote I/O Modules
Environmental Requirements

NOTE: The BMXCRA31210 is also available in a coated version.

Parameter Reference Specification
protection EN 61131-2 IP20

IEC 60527
protection class EN 61131-2 protection class 1
over voltage class EN 61131-2 category II
operating temperature IEC 60068-2-1 0 ... 60° C

Ab&Ad (cold)
IEC 60068-2-2
Bb&Bd (cold)

storage temperature IEC 60068-2-1 -40 ... 85° C
Ab&Ad (cold)
IEC 60068-2-2
Bb&Bd (cold)

sinusoidal vibration IEC 60068-2-6fC  .5 ... 8.4 Hz at 3.5 mm constant amplitude
 8.4 ... 150 Hz at 1g constant acceleration
 10 cycles at sweep rate of 1 oct/min

EN 61131-2

operating shock IEC 60068-2-27Ea 30 g peak, 11 ms, half-sine wave, 3 shocks in each 
direction (+ and -) for each of the 3 principle axes

altitude 0 ... 5000 m maximum during operation. For altitudes 
> 2000 m, reduce the operating temperature by 6° C 
for each additional 1000 m.

free fall, random (packaged) EN 61131-2 5 random drops from 1 m onto flat surfaces
IEC 60068-2-32
test ed., method 1

free fall, flat drop (unpackaged) EN 61131-2  2 random drops from 1 m onto flat surfaces
 5 drops from 0.1 m onto flat surfacesIEC 60068-2-32

test ed., method 1
free fall, angled (unpackaged) EN 61131-2 5 drops from 0.1 m onto each corner

IEC 60068-2-31
relative humidity (operating) IEC 60068-2-78Ca 93% (+/- 2%, noncondensing) at 60° C for conformally 

coated modules 140CRA31200C and 
140CRP31200C

relative humidity (nonoperating) IEC 60068 93% (+/- 2%, noncondensing) at 60° C for conformally 
coated modules 140CRA31200C and 
140CRP31200C
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Characteristics of Ethernet Remote I/O Modules
I/O Devices

Introduction
This topic lists the Quantum and Modicon X80 I/O devices that can be connected to an Ethernet 
remote I/O network.
To add I/O modules to an Ethernet remote I/O drop in Control Expert offline mode, click and drag 
the modules from the Hardware Catalog to the remote I/O drop in the bus editor. You can also 
double-click the rack slot in which you want to insert the I/O module and select from the New 
Device dialog box. The available I/O modules are listed in the following tables.

Quantum Analog and Digital Modules
These analog and digital I/O modules are supported in Quantum Ethernet remote I/O drops:

Input Output Input/Output
Analog I/O Modules:
140 ACI 030 00 140 ACO 020 00 140 AMM 090 00
140 ACI 040 00 140 ACO 130 00
140 AII 330 00 140 AIO 330 00
140 AII 330 10 140 AVO 020 00
140 ARI 030 10
140 ATI 030 00
140 AVI 030 00
Digital I/O Modules:
140 DDI 153 10 140 DDO 153 10 140 DDM 390 00
140 DDI 353 00 140 DDO 353 00 140 DDM 690 00
140 DDI 353 10 140 DDO 353 01 140 DAM 590 00
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Characteristics of Ethernet Remote I/O Modules
Modicon X80 Analog and Digital Modules
These analog and digital I/O modules are supported in Modicon X80 Ethernet remote I/O drops:

140 DDI 364 00 140 DDO 353 10
140 DDI 673 00 140 DDO 364 00
140 DDI 841 00 140 DDO 843 00
140 DDI 853 00 140 DDO 885 00
140 DAI 340 00 140 DAO 840 00
140 DAI 353 00 140 DAO 840 10
140 DAI 440 00 140 DAO 842 10
140 DAI 453 00 140 DAO 842 20
140 DAI 540 00 140 DAO 853 00
140 DAI 543 00 140 DRA 840 00
140 DAI 553 00 140 DRC 830 00
140 DAI 740 00 140 DVO 853 00
140 DAI 753 00 140 DIO 330 00
140 DII 330 00
140 DSI 353 00

Input Output Input/Output

Input Output Input/Output
Analog I/O Modules:
BMX ART 0414 BMX AMO 0210 BMX AMM 0600
BMX ART 0814 BMX AMO 0410
BMX AMI 0410 BMX AMO 0802
BMX AMI 0800
BMX AMI 0810
Digital I/O Modules:
BMX DDI 1602 BMX DDO 3202K BMX DDM 16022
BMX DDI 1603 BMX DDO 6402K BMX DDM 16025
BMX DDI 1604 BMX DDO 1602 BMX DDM 3202K
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Characteristics of Ethernet Remote I/O Modules
NOTE: Schneider Electric recommends that you use Unity Loader to upgrade the module with the 
latest available version. However, a BMX ART 0414 module, V2.1 or later, can work properly 
behind a Modicon X80 remote I/O adapter module.

Intelligent and Special Purpose Modules
These intelligent/special purpose modules are supported in Quantum and Modicon X80 Ethernet 
remote I/O drops:

NOTE: Schneider Electric recommends that you use Unity Loader to upgrade the module with the 
latest available version. However, a BMX NOM 0200 module, V1.4 or later, can work properly 
behind a Modicon X80 remote I/O adapter module.

BMX DAI 0805 BMX DDO 1612
BMX DAI 0814 BMX DAO 1605
BMX DAI 1602 BMX DAO 1615
BMX DAI 1603 BMX DRA 0804
BMX DAI 1604 BMX DRA 0805
BMX DAI 1614 BMX DRA 0815
BMX DAI 1615 BMX DRA 1605
BMX DDI 3202K BMX DRC 0805
BMX DDI 6402K

Input Output Input/Output

Type Quantum Module Modicon X80 Module
BMX CRA 312 00 BMX CRA 312 10

expert 140 ERT 854 10 — BMX ERT 1604T
140 ERT 854 20
140 ESI 062 10

counting 140 EHC 105 00 — BMX EHC 0200
140 EHC 202 00 — BMX EHC 0800

communication 140 XBE 100 00 — BMX NOM 0200.
Restrictions are described in chapter 
BMXNOM0200 Limitation and Implementation 
Rules (see Modicon X80, BMXNOM0200 
Serial Link Module, User Manual).
BMX EIA 100 (max of 1 per drop; may be 
combined with one BMX NOM 0200 module)

fiber cable 
conversion

140 NRP 312 00/01 BMX NRP 0200/01
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Characteristics of Ethernet Remote I/O Modules
Modicon X80 Analog and Digital Module Versions
When the following modules are used in an EIO drop with a BMX CRA 312 10 adapter module, 
they require these versions (or later):

Module Product Version Hardware Release Level Software Version
BMX AMI 0410 PV5 RL5 SV1.1
BMX AMM 0600 PV5 (PV6) RL5 (RL6) SV1.2
BMX AMO 0210 PV7 (PV8) RL7 (RL8) SV1.1
BMX ART 0414 PV5 (PV6) RL5 (RL6) SV2.0

PV7 RL7 SV2.1
BMX ART 0814 PV3 (PV4) RL3 (RL4) SV2.0

PV5 (PV6) RL5 (RL6) SV2.1
BMX EHC 0200 PV3 RL3 SV1.1
BMX EHC 0800 PV3 RL3 SV1.1
S1A48978 12/2018 27



Characteristics of Ethernet Remote I/O Modules
28 S1A48978 12/2018



Quantum EIO
Installation
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Installation

Chapter 2
Installation

Overview
This chapter describes the hardware installation of a Quantum EIO system. It includes the 
installation of modules in the local rack and the Ethernet remote I/O drop to which it is connected. 
Other discussions include the interconnections between rack-mounted modules and the hardware 
considerations for different PLC platforms.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
2.1 Installing Quantum EIO Modules 30
2.2 Installing the Communications Adapter on the Remote Drop 38
2.3 Remote I/O Infrastructure Cables 43
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Installation
Installing Quantum EIO Modules

Section 2.1
Installing Quantum EIO Modules

Introduction
This section describes the installation of these Quantum EIO modules:
 140CRP31200 remote I/O head module (on the local rack)
 140CRA31200 remote I/O adapter module (on a Quantum remote I/O drop)
 140CRA31908 remote I/O adapter module (for S908 applications)
 BMXCRA312•0 remote I/O adapter module (on a Modicon X80 remote I/O drop)

What Is in This Section?
This section contains the following topics:

Topic Page
Installing the Quantum Controller 31
Mounting a Quantum EIO-Compatible Module on the Backplane 32
Quantum EIO-Compatible Module Installation Considerations 34
Remote I/O Network Cable Installation 36
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Installation
Installing the Quantum Controller

Introduction
For any Quantum EIO system, install a Quantum controller on the local rack. Only processors with 
firmware version 3.0 or later (version 3.10 for BMXCRA312•0 support) are compatible with 
Quantum EIO installations. 

Compatible Processors
Compatible processors:

NOTE: Low-end Quantum processors (140 CPU 434 12U, 140 CPU 534 14U, 140 CPU 311 10) 
and Quantum safety processors (140 CPU 651 60S, 140 CPU 671 60S) are not compatible with 
Quantum EIO systems.

Selecting a Power Supply
When installing a Quantum controller, add a power supply module that is capable of supplying 
power to all modules on the rack. 

Processor Type Part
standalone 140 CPU 651 50

140 CPU 651 60
140 CPU 652 60
140 CPU 658 60

Hot Standby 140 CPU 671 60
140 CPU 672 60
140 CPU 672 61
140 CPU 678 61
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Installation
Mounting a Quantum EIO-Compatible Module on the Backplane

Introduction
Use these instructions to install Quantum and Modicon X80 modules that operate in a Quantum 
EIO system:
 140CRP31200 remote I/O head module (on the local rack)
 remote I/O adapter module:
 140CRA31200 remote I/O adapter module (on a Quantum remote I/O drop)
 BMXCRA312•0 adapter module (on a Modicon X80 remote I/O drop)
 140CRA31908 adapter module facilitates the use of S908 hardware and applications in 

M580 Ethernet I/O architectures.
 140NOC78000 distributed I/O head module (on the local rack)
 140NOC78100 control head module (on the local rack)

Grounding Considerations
Do not apply power to a Quantum rack until connections are made at both ends of the Ethernet 
cable. For example, connect the cable to both the 140CRP31200 and another device (adapter 
module) or ConneXium dual-ring switch DRS before you turn on the power.
Refer to the Quantum EIO System Planning Guide for details on dual-ring switches (DRSs).

Use fiber-optic cable to establish a communications link when it is not possible to master potential 
between distant grounds.

DANGER
ELECTRICAL SHOCK HAZARD
 Switch off the power supply to the automation controller stations at both ends of the connection 

before inserting or removing an Ethernet cable.
 Use suitable insulation equipment when inserting or removing all or part of this equipment.
Failure to follow these instructions will result in death or serious injury.
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Installation
Mounting a Module

NOTE: The figure above shows a Quantum module being mounted from top to bottom. 
Modicon X80 modules mount from bottom to top.

Replacing a Module
You can replace a Quantum EIO module at any time using another module with compatible 
firmware. The replacement module obtains its operating parameters over the backplane 
connection from the CPU. The transfer occurs immediately at the next cycle to the device.
The operating parameters that the CPU sends to a replacement module do not include any 
parameter values that were edited in the original module using explicit messaging SET commands.

Step Action
1 Hold the module at an angle and mount it on the 2 hooks near the top of the backplane. The figure 

shows the correct way to hold the module:

2 Swing the module down so the connector engages the backplane connector.
3 Use a Phillips-head screw driver to tighten the screw at the bottom of the module from 2 to 4 in-lbs 

or from .22 through .45 N•m of torque.
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Quantum EIO-Compatible Module Installation Considerations

Introduction
Observe the following guidelines when you install these Quantum and Modicon X80 modules in a 
Quantum EIO system:
 140CRP31200 remote I/O head module (on the local rack)
 remote I/O adapter module (on the remote I/O drop)
 140CRA31200 module on a Quantum drop
 140CRA31908 adapter module on a Quantum drop
 BMXCRA312•0 module on a Modicon X80 drop

 140NOC78000 distributed I/O head module (on the local rack)
 140NOC78100 control network head module (on the local rack)

Grounding Considerations

Use fiber-optic cable to establish a communications link when it is not possible to master potential 
between distant grounds.
NOTE: Refer to the ground connections information in the Grounding and Electromagnetic 
Compatibility of PLC Systems User Manual.

Installation
You can apply power to the Quantum EIO controller rack after the 140CRP31200 head module or 
adapter module is inserted:
 Successful installation:
 Initialization is finished.
 Interconnections to other modules are validated (drop adapter module only).

 Unsuccessful installation:
 Initialization does not finish.
 Interconnections to other modules are not validated (adapter modules only).

You can see the status of the installation on the LED display.

DANGER
ELECTRICAL SHOCK HAZARD
 Switch off the power supply to the automation controller stations at both ends of the connection 

before inserting or removing an Ethernet cable.
 Use suitable insulation equipment when inserting or removing all or part of this equipment.
Failure to follow these instructions will result in death or serious injury.
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Installation
NOTE: Because all modules on the local rack are initialized when power is applied, the 
140CRP31200 remote I/O head module can only validate the interconnections with 140NOC78000 
and 140NOC78100 head modules after these modules have been initialized. Therefore, the 
adapter module waits until its queries about the interconnected port information are answered.
NOTE: These guidelines pertain to the installation of a single head module or adapter module, not 
the entire network. For network power-up guidelines, refer to the Quantum Ethernet I/O System 
Planning Guide.
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Installation
Remote I/O Network Cable Installation

Introduction
Your application can include:
 communications with a simple remote I/O daisy chain loop
 communications with a mix of remote I/O and distributed I/O networks
The cable connections to the 140CRP31200 remote I/O head module on the local rack are different 
in these scenarios. They are discussed below.
Each device network port on the 140CRP31200 module is connected to the main ring of the daisy 
chain. Likewise, each device network port on a 140CRA31200 or BMXCRA312•0 adapter module 
is connected to an Ethernet I/O device. The 140CRP31200 module and the •••CRA312•0 adapter 
modules do not have fiber optic ports.
The Ethernet ports are clearly labeled (see page 15) on the 140CRP31200 module and the 
•••CRA312•0 adapter modules.

Remote I/O Simple Daisy Chain Loop
The 140CRP31200 module supports communications with Ethernet remote I/O drops in daisy 
chain loops:

1 local rack with a 140CRP31200 remote I/O head module
2 Modicon X80 remote I/O drop with a BMXCRA312•0 adapter module
3 Quantum remote I/O drop with a 140CRA31200 adapter module
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Installation
When you support only remote I/O, you do not have to link the 140CRP31200 module to other 
communication modules on the local rack.

Mix of Remote I/O Drops, Distributed I/O Devices, and Clouds
The Quantum EIO architecture allows distributed I/O devices to participate directly on the remote 
I/O network. This can be useful if, for example, you want to integrate a SCADA or HMI panel or 
other non-Quantum device into the remote I/O network.
Distributed I/O devices cannot be connected directly to the main ring of the remote I/O network, 
but they can be connected via a DRS. Most DRS preconfigurations enable some switch ports to 
support distributed I/O clouds:

1 main ring
2 140CRP31200 interlinked to 140 NO• 7•• module on the local rack
3 dual-ring switch (DRS)
4 dual-ring switch (DRS) connection to distributed I/O sub-ring
5 dual-ring switch (DRS) connection to distributed I/O cloud

Some dual-ring switch (DRS) preconfigurations support the connection of distributed I/O devices 
connected directly to a sub-ring. In these configurations, the distributed I/O devices have the 
advantage of cable redundancy provided by the sub-ring loop. In order for a distributed I/O device 
to operate on a sub-ring, use a device with 2 Ethernet ports that support RSTP.
The above figure shows two STB islands used as distributed I/O devices on a sub-ring. The 
network interface module installed in each island is an STB NIP 2311 NIM, which has dual 
Ethernet ports and the RSTP service.
S1A48978 12/2018 37



Installation
Installing the Communications Adapter on the Remote Drop

Section 2.2
Installing the Communications Adapter on the Remote Drop

Introduction
This section describes the installation of the 140CRA31200 or BMXCRA312•0 adapter module in 
an Ethernet remote I/O drop.

What Is in This Section?
This section contains the following topics:

Topic Page
Installing a Quantum EIO Adapter Module 39
Installing Ethernet Remote I/O Drops on a Remote Rack 40
Setting the Location of the Ethernet Remote I/O Drop 42
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Installation
Installing a Quantum EIO Adapter Module

Locate a Backplane Slot
Install the 140CRA31200 adapter module in any slot in the remote I/O drop. Insert the 
BMXCRA312•0 adapter module in slot 0 only in the remote I/O drop.
Refer to the directions for installing a module on the backplane (see page 32).

Power Consumption
Power consumption is 1.2 A on a 5 Vdc power rail on the backplane (6 W). The adapter module 
supports modules on 2 racks. (Power consumption has no relation to the number of installed rack 
modules.)

Select a Power Supply
When configuring the PLC station, use a power supply module that can supply power to all rack 
modules.
NOTE: You can place a power supply module in any slot on Quantum Ethernet remote I/O drop. 
In Modicon X80 Ethernet remote I/O drops, you can insert the power supply only in the double-wide 
slot to the left of slot 0.
Select a power module that suits your unique system requirements. These modules (and their 
conformally coated versions) are supported:

Power Supply Type Quantum Module Modicon X80 Module
standalone  140 CPS 21 00 (C)

 140 CPS 511 00 (C)
 140 CPS 111 00 (C)

 BMX CPS 2010
 BMX CPS 3020
 BMX CPS 2000
 BMX CPS 3500
 BMX CPS 3540
 BMX CPS 4002

summable  140 CPS 214 00 (C)
 140 CPS 414 00 (C)
 140 CPS 114 20 (C)

–

redundant  140 CPS 224 00 (C)
 140 CPS 424 00 (C)
 140 CPS 524 00 (C)
 140 CPS 124 20 (C)

 ABL 8RED 24400
 ABL 8REM 24030
 ABL 8RPS 24030
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Installing Ethernet Remote I/O Drops on a Remote Rack

Introduction
These guidelines apply to Ethernet remote I/O drops on remote racks.

Racks and Extensions
An Ethernet remote I/O drop can include 2 racks. In a 2-rack drop, the racks are linked with these 
bus extender modules and cables:

Maximum Configuration
Quantum remote I/O drops can include two 16-slot racks for a maxiumum of 32 slots. Modicon X80 
remote I/O drops with a BMXCRA312•0 adapter module can support two racks for a maximum of 
24 slots.
NOTE: If you use a low-end CPU (140 CPU 6• 1••) (2 Mb or less), you can only install a maximum 
of 31 remote I/O drops. Of those 31 drops, you can only install a maximum of sixteen 
BMXCRA312•0 remote I/O drops. If you use a high-end CPU (140 CPU 6•• ••) (4 Mb or more), you 
can install a maximum of thirty-one BMXCRA312•0 or 140CRA31200 remote I/O drops.
The table shows the maximum number of modules of each type in remote drops:

 NOTE 1:
 140CRA31200: This adapter module consumes 1 slot in the main (first) rack in Quantum 

remote drops. The extended (second) rack in a Quantum remote I/O drop does not require 
an adapter.

 BMXCRA312•0: This adapter module supports a Modicon X80 remote I/O drop with 2 racks 
when a bus extender module is in both the main and extended racks.

Remote Drop Type Bus Extender Module Cable
Quantum 140 XBE 100 00 140 XCA 717 0• (1 to 3 m)
Modicon X80 BMX XBE 1000 BMX XBC •••K (0.8 to 12 m)

Module Type Quantum 140CRA31200 Modicon X80 BMXCRA312•0
remote I/O adapter (note 1) 1 1
power supply (note 2) 2 2
bus extension (note 3) 2 2
I/O 27 23
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Installation
 NOTE 2: A power supply consumes 1 dedicated slot in each rack in Quantum and Modicon X80 
remote I/O drops.

 NOTE 3: A bus extender module is required for each rack in remote I/O drops. In Quantum 
remote I/O drops, the bus extender consumes 1 rack slot. In Modicon X80 remote I/O drops, the 
bus extender attaches to the end of the rack and does not consume a rack slot.

Refer to the list of modules that remote I/O installations support (see page 24).
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Setting the Location of the Ethernet Remote I/O Drop

Setting Rotary Switches
Set the location of the Ethernet remote I/O drop on the network with the rotary switches on the front 
of the 140CRA31200 or BMXCRA312•0 adapter module before you apply power to the module and 
before you download the application:

The values you set are applied during a power cycle. If you change the switch settings after the 
module has powered up, the Mod Status LED is activated and a mismatch message is logged in 
the module diagnostic.
Because new values on the rotary switches are implemented only at the next power cycle, we 
recommend that you set the value before starting the module. (Valid values: 00 ... 159)
The values on the rotary switches combine with the device prefix (for example, 140CRA_xxx or 
BMXCRA_xxx) to create the device name (where xxx represents the value of the rotary switches). 
The preceding figure shows the Tens switch set to 0 and the Ones switch set to 01, for a device 
name of 140CRA_001.
NOTE:
 The rotary switches can be manipulated with a small flat-tipped screwdriver.
 No software is required to configure or enable the rotary switches.
 Do not use the Stored and Clear IP settings on the Ones rotary switch. (The functionality of 

these settings does not apply to remote I/O installations.)
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Section 2.3
Remote I/O Infrastructure Cables

What Is in This Section?
This section contains the following topics:

Topic Page
Cable Installation 44
Duplicate IP Address Checking 46
Loss of I/O Connection 47
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Cable Installation

Introduction
Observe these guidelines when making cable connections between remote I/O devices on a 
Quantum EIO installation. (Remote I/O devices include local racks, remote I/O drops, or DRSs.)
A copper cable connection between 2 consecutive remote I/O devices cannot exceed 100 m. A 
fiber cable connection between 2 consecutive remote I/O devices cannot exceed 15 km (single 
mode) or 2.5 km (multi-mode).

Connections Between Devices
This figure shows the distances between remote I/O devices in Quantum EIO installations:

1  140CRP31200 remote I/O head module
2 140NOC78000 distributed I/O head module
3 140NOC78100 control head module
4 DRS (with copper and fiber ports): This DRS extends the distance between devices using fiber cable (up 

to 15 km). 
5 distributed I/O sub-ring connected to the main ring via (4)
6 fiber cable portion of the main ring used to separate the DRSs beyond 15 km
7 copper cable (twisted pair) portion of the main ring
8 remote I/O drop
9 DRS (with copper ports only): This DRS extends the distance between devices.
10 control network
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NOTE: We recommend the use of shielded twisted pair CAT5e (10/100 Mbps) cables, ideally 
ConneXium 490NT•000••.

Interlink
To support distributed I/O sub-rings in Quantum EIO installations, establish an interlink between 
an Ethernet communication module on the local rack and the 140CRP31200 remote I/O head 
module:

1 local rack, including a 140 NOC 780 00 distributed I/O head module that is interlinked with a 140CRP31200 
remote I/O head module

2 DRS connected to the main ring and a distributed I/O sub-ring
3 distributed I/O sub-ring

NOTE: For the interlink connection, we recommend the use of shielded twisted pair CAT5e (10/100 
Mbps) cables.
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Introduction
Each Quantum EIO module has a single IP address. Therefore, the address conflict detection 
algorithm (also called duplicate IP checking) is performed based on the status (link up, link down) 
of the ports.

Link Down
These conditions apply when links are lost:

Link Up
These conditions apply when links are added:

Link Status Description
A transition has occurred 
from 1 connected link to 
all links down.

When no module ports are connected to a cable (all links are down), all services 
are reset. For example, I/O connections, Modbus connections, and explicit 
EtherNet/IP connections close, but low-level network services (like RSTP or 
switches) are not affected. The updated Net Status LED indicates the status.

There is 1 link down and 
at least 1 connected link.

There is no impact on services that are running in the module.

Link Status Description
A transition has occurred 
from no connected links to 
1 connected link.

A duplicate IP check is performed:
 no duplicate: All services start.
 duplicate: I/O services stop. The 140CRA31200 or BMXCRA312•0 adapter 

module gets new configuration and downloads the IP configuration again. 
The system goes to default IP and I/O modules are set to fallback mode.

A transition has occurred 
from at least 1 connected 
link to an additional 
connected link.

A duplicate IP check is performed:
 no duplicated: All services continue.
 duplicate: All services stop.

NOTE: The updated Net Status LED indicates the status.
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Loss of I/O Connection

Conditions
An I/O connection can be lost under these conditions:

Remote Adapter Fallback
In some instances, the 140CRA31200 or BMXCRA312•0 adapter module on the remote I/O drop 
can lose I/O connections for a period longer than the configured hold up time. During the hold up, 
the adapter tries to get IP and configuration parameters from the 140CRP31200. If the adapter 
does not obtain those parameters, it gets these results:
 inputs: retain last known values
 outputs: set to fallback
NOTE: Configure the hold up time on the Control Expert Parameter tab (see page 71).

Condition CPU 140CRP31200 Adapter Module 
(140CRA31200 or 
BMXCRA312•0)

 Perform a hot swap.
 Replace a module of the same 

type.

X X X

There is no remote I/O cable 
connection.

X X

The I/O connection is closed.* X
*Hot swap of the CPU results in an explicit close (lost I/O connection).
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Chapter 3
Configuration and Programming with Control Expert

Introduction
Use Control Expert to configure your local rack and remote drops for Ethernet communications.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
3.1 Creating a Control Expert Project 50
3.2 Control Expert Configuration for Remote I/O Ethernet Modules 58
3.3 Control Expert Configuration for Ethernet Remote I/O Drops 67
3.4 Derived Data Types 77
3.5 Elementary Functions (EFs) and Function Blocks (EFBs) 89
3.6 Application Download 91
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Creating a Control Expert Project

Section 3.1
Creating a Control Expert Project

Introduction
Use the instructions in this section to create a Control Expert project that allows communication 
between a local rack and an Ethernet remote I/O drop. Here are the basic stages of the Control 
Expert configuration:
1. Select a high-end Quantum processor to create a new Control Expert configuration.
2. Add a power supply to the local rack.
3. Add an Ethernet remote I/O head module (140 CRP 312 00) to the local rack.
4. Configure a rack assembly for the Ethernet remote I/O drop.
NOTE: These instructions assume that you have a working knowledge of Control Expert.

What Is in This Section?
This section contains the following topics:

Topic Page
Configuring the Local Rack 51
Configuring the Ethernet Remote I/O Drop 53
Available Control Expert Configuration Tabs 55
NTP Configuration in Control Expert 56
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Configuring the Local Rack

Assemble a Local Rack
In Control Expert, assemble a Quantum rack:

The local rack in your Control Expert configuration should look like this:

Step Action Comment
1 In Control Expert, create a project. Click File → New.

Result: The New Project window appears.)
2 Add a PLC from the New Project 

window.
For this example, double-click the 140 CPU 651 50 module. 
(New Project → Quantum → 140 CPU 651 50).

3 In the Project Browser, double-click 
Local Bus.

Click Tools → Project Browser → Configuration → Local 
Bus.
Result: The Local Bus window opens, and the rack includes 
the processor you selected.)

4 Add a power supply to the Local 
Bus.

Drag the module to slot 1. (Tools → Hardware catalog → 
Local Quantum Drop → Supply → 140 CPS 114 X0)

5 Add a 140 CRP 312 00 remote I/O 
head module to an available slot in 
the local rack.

Drag the module to slot 4. (Tools → Hardware catalog → 
Local Quantum Drop → Communication → 
140 CRP 312 00)

6 Use the same method to add a 
140 NOC 780 00 distributed I/O 
head module to the Local Bus.

Drag the module to slot 5. (Tools → Hardware catalog → 
Local Quantum Drop → Communication → 
140 NOC 780 00)

7 Double-click any empty slot to add 
modules to the Local Bus.

This step is optional, but you can provide Ethernet 
transparency between the device network and the control 
network by adding a 140 NOC 781 00 control head module 
to the local rack.

8 Save the file. Click File → Save.
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Note that the Local Bus contains these modules:
 power supply (140 CPS 114 •0)
 CPU (140 CPU 651 50)
 remote I/O head module (140 CRP 312 00)
 distributed I/O head module (140 NOC 780 00)
 control head module (140 NOC 781 00)

Rack Parameters
Double-click the 140 CRP 312 00 module in the Local Bus window to access these configuration 
parameters for the local rack:
 IP Config (see page 59)
 RSTP (see page 61)
 SNMP (see page 62)
 NTP (see page 56)
 Service port (see page 64)
 Device DDT (see page 74)
NOTE: You can accept the automatically assigned IP address or change the IP address in the 
Control Expert IP Config tab.

Rack Considerations
Remember:
 The copy/cut/paste commands are not available for the 140CRP31200 module.
 You can cut or copy other devices in the local rack or the drop and paste them in any rack of the 

same type. You can perform these actions (cut, copy, paste) only in the same device editor. You 
cannot move objects from the local rack to the drop or vice-versa.

 The number of the first slot in a rack is 1. Therefore, a 4-slot rack has slot numbers 1, 2, 3, 4.
NOTE: If you use a low-end CPU (140 CPU 6• 1••) (2 Mb or less), you can only install a maximum 
of 31 remote I/O drops. Of those 31 drops, you can only install a maximum of sixteen 
BMXCRA312•0 remote I/O drops. If you use a high-end CPU (140 CPU 6•• ••) (4 Mb or more), you 
can install a maximum of thirty-one BMXCRA312•0 or 140CRA31200 remote I/O drops.
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Configuring the Ethernet Remote I/O Drop

Instructions
In the previous topic, you added a 140CRP31200 module to the local rack in a Control Expert 
project (see page 51). The 140CRP31200 remote I/O head module supports communication with 
an Ethernet remote I/O rack.
When you insert a 140CRP31200 module in the local rack, Control Expert automatically creates 
an EIO Bus, which has the same capabilities as an existing S908 legacy remote I/O bus.
In the EIO Bus, you can select a Quantum drop or an Modicon X80 drop.
Within an Modicon X80 drop, the BMXCRA31200 adapter module is inserted by default. This 
module supports only standard digital and analog modules. Insert a BMXCRA31210 module from 
the Drop end communicator field if you require more functionality, such as the following:
 service port (see page 21)
 expert modules
 time stamping (see page 56)
 CCOTF
NOTE: If you use a low-end CPU (140 CPU 6• 1••) (2 Mb or less), you can only install a maximum 
of 31 remote I/O drops. Of those 31 drops, you can only install a maximum of sixteen 
BMXCRA312•0 remote I/O drops. If you use a high-end CPU (140 CPU 6•• ••) (4 Mb or more), you 
can install a maximum of thirty-one BMXCRA312•0 or 140CRA31200 remote I/O drops.
Use these instructions to configure a remote rack (EIO Bus) that includes a 140CRA31200 or 
BMXCRA312•0 adapter module in slot 1:

Step Action Comment
1 In the Project Browser, double-click EIO Bus to 

see the (empty) drop.
(Tools → Project Browser → Structural view → 
Project → Configuration → EIO Bus)

2 In the EIO Bus window, double-click the square 
link connector to access the available racks.

The New Device window appears.

3 Select a rack for a Quantum Ethernet I/O drop or 
a Modicon X80 Ethernet I/O drop.

NOTE: If you select a Modicon X80 drop, also 
choose a BMXCRA31200 or BMXCRA31210 
adapter module in the Drop end communicator 
field of the New Device window.

This example uses the 4-slot 140 XBP 004 00 
rack: New Device → Part Number → EIO 
Quantum Drop → Rack → 140 XBP 004 00. 
Select the device and press OK. 

4 Double-click any empty slot to add modules to 
the EIO Bus.

For this example, this step is optional.

5 Save the file. Click File → Save.
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The Control Expert configuration now includes the remote rack window (EIO Bus). Because the 
Ethernet remote I/O drop requires a module for communication with the local rack, Control Expert 
automatically adds an adapter module in slot 1.

Rack Parameters
The adapter module is now installed as the communications adapter module of your Ethernet 
remote I/O drop. Double-click the adapter to see its configuration tabs:
 RSTP (see page 61)
 SNMP (see page 62)
 Service port (see page 64)

Rack Considerations
Remember these points:
 You can insert 2 racks on a Modicon X80 Ethernet remote I/O drop with a BMXCRA31210. You 

can only insert 1 rack with a 140CRA31200 module.
 Control Expert automatically inserts BMXCRA312•0 adapter modules in slot 0. You cannot 

delete or move these modules.
 The number of the first slot in a Quantum rack is 1. The number of the first slot in a Modicon X80 

rack is 0. Therefore, a 4-slot Quantum rack includes slot numbers 1, 2, 3, 4, and a 4-slot 
Modicon X80 rack includes slot numbers 0, 1, 2, 3.

 You can cut or copy other devices in the remote drop and paste them in any rack of the same 
type. You can perform these actions (cut, copy, paste) only in the same device editor. You 
cannot move objects from the local rack to the drop or vice-versa.
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Available Control Expert Configuration Tabs

About the Parameters
The Control Expert configuration tabs are available after you have configured these:
 local rack (including a 140CRP31200 remote I/O head module) (see page 51)
 Ethernet remote I/O drop (including a 140CRA31200 or BMXCRA312•0 remote I/O adapter 

module) (see page 53)

Control Expert Configuration Tabs
This table indicates the available Control Expert configuration tabs for the local rack’s 
140 CRP 312 00 head module and the remote I/O drop’s adapter module:

Control Expert Tab 140CRP31200 Head Module (Local 
Rack)

•••CRA312•0 Adapter Module 
(Remote I/O Drop)

IP Config 
(see page 59)

X (See note.)

RSTP (see page 61) X X
SNMP (see page 62) X X
Service port 
(see page 64)

X X

Device DDT 
(see page 77)

X X

Time Stamping 
(see page 56)

X X (BMXCRA31210 only)

NOTE: The adapter module (140CRA31200 or BMXCRA312•0) automatically receives an IP address. To 
maintain unique addressing on the network, keeping and using the auto-assigned IP addresses is generally 
considered a good practice.
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NTP Configuration in Control Expert

Introduction
This topic describes the Control Expert NTP (time stamp) parameters for the BMXCRA31210 
module. To access these parameters on the Control Expert NTP tab, double-click the 
communication module in the local rack (see page 51).

Access the NTP Tab
To access the NTP tab, open the Bus Editor, double click on the CRP module and then select the 
NTP tab:

Valid IP addresses for NTP servers:
 1.0.0.0 ... 126.255.255.255
 128.0.0.0 ... 223.255.255.255
For any other IP address, a detected error is reported. Addresses 224.0.0.0 and higher are 
experimental multicast addresses. Addresses starting at 127 are loopback addresses.

Field Parameter Value Comment
NTP server 
configuration for 
adapter modules

IP address of Primary NTP Server a.b.c.d (0.0.0.0) entered value
IP address of Secondary NTP Server
Polling period 1, 120 (5)

online behavior — — disabled in connected mode

NOTE: For time zones that support daylight saving time (DST), the default value is enabled (checked). It is disabled 
(unchecked) for all time zones that don't support DST.
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Setting the Time Zone
Set the time zone in the Project Settings window:

Set the time zone:

Step Action
1 In Control Expert, select Tools → Project Settings.
2 Expand the General menu in the Projects Settings window, and select the Time setting.
3 Select the appropriate values for each time zone property.
4 Click Apply to save changes, or click OK to save changes and close window.
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Section 3.2
Control Expert Configuration for Remote I/O Ethernet Modules

Overview
This section describes the module configuration tabs in Control Expert. Use the parameters on 
these tabs to configure services for the 140CRP31200 module in the local rack and the adapter 
module (140CRA31200 or BMXCRA312•0) in Ethernet remote I/O drops.

What Is in This Section?
This section contains the following topics:

Topic Page
IP Configuration 59
RSTP Bridge Configuration 61
SNMP Agent Configuration 62
Service Port Configuration 64
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IP Configuration

Access the IP Config Tab
The Control Expert IP configuration parameters apply to the 140CRP31200 head module in the 
local rack. To access the IP Config tab, double-click on the 140CRP31200 module (see page 51):

IP Config Parameters
Configure the IP parameters for the 140CRP31200 head module in the IP address configuration 
field on the IP Config tab:

Parameter Description Default Value
IP address A The address corresponds to the 140CRP31200 module. 192.168.10.1
IP address B This address is used for Hot Standby configurations.

NOTE: If you change IP address A, the system may recalculate all IP 
addresses (including those of the drops) to keep all devices in the same 
subnet.

IP address A + 1

Subnetwork 
mask

This bit mask identifies or determines the IP address bits that correspond 
to the network address and the subnet portion of the address. (The value 
can be changed to any valid value in the subnetwork.)

255.255.0.0

Gateway 
address

This is the IP address of the default gateway to which messages for other 
networks are transmitted.

0.0.0.0 (when not 
used)
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Configure the IP parameters for the adapter module (in the remote drop) in the CRA IP address 
configuration field on the IP Config tab:

Parameter Description Default Value
Drop No. drop number —
Device Name device name (140CRA31200 or BMXCRA312•0 adapter) —
IP Address When an Ethernet remote I/O drop is added, the adapter module is 

automatically assigned an IP address. (You can change this 
IP address in the IP Address column, but we recommend that you 
accept the automatically assigned IP address.)

—
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RSTP Bridge Configuration

About RSTP
Use RSTP to design a network with redundant cabling so that remote I/O communications 
automatically find an alternate path if a communication disruption occurs (for example, a cable 
breaks or a device becomes inoperable). This method does not require you to manually enable or 
disable communication paths.
Changing these parameters can affect sub-ring diagnostics, I/O determinism, and network 
recovery times.

Access the RSTP Tab
You can access the RSTP parameters in Control Expert by double-clicking these modules in the 
Control Expert rack view:
 head module on the local rack (140CRP31200)
 adapter module on the remote drop (140CRA31200 or BMXCRA312•0)
The RSTP tab appears:

Parameters
This table shows the Bridge priority parameters for the RSTP Operational State on the Control 
Expert RSTP tab:

Bridge Priority Value 140CRP31200 Adapter Module
Root 0 default —
Backup Root 4096 for Hot Standby (automatic) —
Participant 32768 — default
NOTE: In Hot Standby systems, the RSTP bridge priority is applied to the 140CRP31200 module in rack A.
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SNMP Agent Configuration

About SNMP
Use the SNMP tab in Control Expert to configure SNMP parameters for these Quantum Ethernet 
I/O modules:
 head module on the local rack (140CRP31200)
 adapter module on the remote drop (140CRA31200 or BMXCRA312•0)
An SNMP v1 agent is a software component of the SNMP service that runs on these modules to 
allow access to diagnostic and management information for the modules. You can use SNMP 
browsers, network management software, and other tools to access this data. In addition, the 
SNMP agent can be configured with the IP addresses of 1 or 2 devices (typically PCs that run 
network management software) to be the targets of event-driven trap messages. Such messages 
inform the management device of events like cold starts and the inability of the software to 
authenticate a device.

Access the SNMP Tab
Double-click these modules in the Control Expert configuration to access their SNMP tabs:
 140CRP31200 head module (local rack)
 140CRA31200 or BMXCRA312•0 adapter module (remote drop)
The SNMP tab appears:

Use the SNMP tab to configure the SNMP agents for the communication modules in the local rack 
and remote drop. The SNMP agent can connect to and communicate with 1 or 2 SNMP managers 
as part of an SNMP service. The SNMP service includes:
 authentication checking, by the Ethernet communication module, of any SNMP manager that 

sends SNMP requests
 management of events or traps
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SNMP Parameters
These parameters are found on the Control Expert SNMP tab:

Online Behavior
Tests are done to verify that the IP addresses of the managers are not:
 multicast
 loopback
 broadcast

Field Parameter Description Value
IP Address 
managers

IP Address manager 1 The address of the first SNMP 
manager to which the SNMP agent 
sends notices of traps.

0.0.0.0 ... 255.255.255.255

IP Address manager 2 The address of the second SNMP 
manager to which the SNMP agent 
sends notices of traps.

Agent Location (SysLocation) device location 31 characters (maximum)
Contact (SysContact) description of the person to contact 

for device maintenance
Enable SNMP manager unchecked (default): You can edit 

the Location and Contact 
parameters.
checked: You cannot edit the 
Location and Contact parameters.

checked/unchecked

Community 
names

Set password that the SNMP agent 
requires to read commands from an 
SNMP manager (default = Public)

15 characters (maximum)
Get
Trap

Security Enable “Authentication 
failure” trap

unchecked (default): not enabled.
checked (enabled): The SNMP 
agent sends a trap notice to the 
SNMP manager if an unauthorized 
manager sends a Get or Set 
command to the agent.

checked/unchecked
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Service Port Configuration

Access the Service Port Tab
Double-click these modules in the Control Expert rack view to access the Control Expert Service 
Port tab:
 head module on the local rack (140CRP31200)
 adapter module on the remote drop (140CRA31200 or BMXCRA31210)
The Service Port tab appears:
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Service Port Parameters
These parameters are on the Control Expert Service Port tab:

On Line Behavior
The Service Port parameters are stored in the application, but you can reconfigure (change) the 
parameters in connected mode. Values that you reconfigure in connected mode are sent to the 
remote drop’s adapter module or 140CRP31200 head module in explicit messages. (The changed 
values are not stored, so a mismatch can exist between the parameters that are being used and 
those that are in the stored application.) If the module does not respond to the explicit messages, 
a message appears.

Field Parameter Value Comment
Service Port Enabled — Enable port and edit port parameters.

Disabled — Disable port parameters.
Service Port 
Mode

Access 
(default)

— This mode supports Ethernet communications.

Mirroring — In port mirroring mode, data traffic from one or more of the other 
ports is copied to this port. A connected tool can monitor and 
analyze port traffic.

NOTE: In this mode, the SERVICE port acts like a read-only port. 
That is, you cannot access devices (ping, connection to Control 
Expert, etc.) through the SERVICE port.

Access Port 
Configuration

Service Port 
Number

ETH1 You cannot edit the value in the Service Port Number field.

Port Mirroring 
Configuration

Source Port(s) Internal Port all Ethernet traffic for the module
ETH2 140CRP31200: all INTERLINK port traffic

adapter modules: Ethernet traffic through the first remote I/O port
ETH3 140CRP31200: Ethernet traffic through the first remote I/O port

adapter modules: Ethernet traffic through the second remote I/O 
port

ETH4 adapter modules: Ethernet traffic through the second remote I/O 
port (140CRP31200 only)
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Limitations
The SERVICE port on the 140CRP31200 head module and the adapter modules have the same 
limitations as the cloud port of the dual-ring switch (DRS). Therefore, the module's cloud port and 
the DRS's cloud port can be connected to the same equipment.
The maximum load the module can process from distributed I/O devices:
 5 Mbps: per SERVICE port
 20 Mbps: total distributed I/O traffic on the main ring
For more information about considerations that apply to the use of the distributed I/O cloud port 
and the service port on the DRS, refer to the Predefined Configuration Files topic in the Quantum 
Ethernet I/O System Planning Guide.
66 S1A48978 12/2018



Configuration and Programming with Control Expert
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Section 3.3
Control Expert Configuration for Ethernet Remote I/O Drops

Introduction
This section discusses the use of Control Expert to configure the Ethernet remote I/O drop and its 
adapter module. It includes descriptions of the parameters on the Configuration, Parameter, and 
Device DDT tabs in Control Expert.
NOTE: These instructions assume that you have already added a remote I/O drop to your Control 
Expert project (see page 40).

What Is in This Section?
This section contains the following topics:

Topic Page
Configuring the Size and Location of Data 68
Configuring the Parameters 70
Device DDT Parameters 74
Time Stamping 76
S1A48978 12/2018 67



Configuration and Programming with Control Expert
Configuring the Size and Location of Data

Introduction
Use the Control Expert Configuration tab to configure the size and location of data for an Ethernet 
remote I/O drop that includes a 140CRA31200 or BMXCRA312•0 remote I/O adapter module.
NOTE: These instructions assume that you have already added a drop to your Control Expert 
project (see page 53).

Access the Configuration Tab
Access the Configuration parameters in Control Expert:

The Configuration tab shows the Parameter Name and the corresponding Value:

Step Action Comment
1 Expand (+) the EIO Bus in the Control 

Expert Project Browser.
(Project Browser → EIO Bus → EIO Quantum Drop/EIO 
Modicon X80 Drop)

2 Double-click the Quantum EIO drop. The EIO drop window appears. It contains the parameter 
tabs from the Ethernet remote I/O drop.

3 Select the Configuration tab. The Configuration tab is available for the Quantum EIO 
drop only.
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Configuration Parameters
On the Control Expert Configuration tab, configure these parameters for the Ethernet remote I/O 
Quantum drop:

NOTE: These parameters do not apply to Modicon X80 drops.

Parameter Name Value
Starting address status table the first register in the status table (configured)
Ending address status table the starting address + the maximum number of addresses for the configured 

rack size
In Bytes the total number of bytes for input modules in the remote I/O drop
Out Bytes the total number of bytes for output modules in the remote I/O drop
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Configuring the Parameters

Parameter Tab (Remote I/O Drop)
This topic describes the Control Expert Parameter tab for an Ethernet remote I/O drop that includes 
a 140CRA31200 or BMXCRA312•0 adapter module.
NOTE: These instructions assume that you have already added a drop to your Control Expert 
project (see page 53).

Access the Parameter Tab
Access the Parameter tab in Control Expert:

The Parameter tab appears:

Step Action Comment
1 Expand (+) EIO Bus in the Control 

Expert Project Browser.
Path: Project Browser → EIO Bus → EIO Quantum 
Drop/EIO Modicon X80 Drop

2 Double-click the EIO drop (Quantum or 
Modicon X80.

The EIO drop window appears. It contains the 
parameter tabs for the remote I/O drop.

3 Select the Parameter tab.
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Parameter Descriptions
Use the Control Expert Parameter tab to configure the following parameters for the Ethernet 
remote I/O drop.
Address information parameters:

Hold up time parameter:

Parameter Comment
Device Name The device name of the device includes a fixed device prefix and a number provided by the 

rotary switch. Valid device names conform to this structure:
 140CRA_xxx
 BMXCRA_xxx
Remember that xxx equals the 3-digit value selected on the rotary switches, so the device 
name includes the device prefix (140CRA or BMXCRA) plus that value.
When the device is placed on the Ethernet remote I/O drop, the number is set to the device 
number. The device number does not change when the device moves to a new location.
Valid device numbers are unique within the application. A message like this appears when 
analysis reveals redundant device numbers:
{EIO Bus (2) 140 CRA 312 00}: Device name is not unique

NOTE: The device number does not change if you move the drop, but you can modify the 
number. However, if you modify the number, the link breaks between the device name and 
the drop number. Schneider Electric recommends that you allow the drop number to equal 
the device name, even if it can be modified.

IP Address You cannot edit the IP address and Sub network (mask) fields. The IP address is editable 
only in the IP Configuration tab (see page 59) of the 140CRP31200 module. The value for 
Sub network is deduced from the 140CRP31200 sub network mask.

Sub Network

Parameter Comment
Hold up time The hold up time represents the time (ms) that device outputs are maintained in their 

current states after a communication disruption and before taking their fallback values:
 default value: 1000 ms
 valid value range: 50...65,530 ms
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The minimum holdup time differs for standalone and Hot Standby systems. If you assign a holdup 
time value that is less than the recommended minimum value, you can send an I/O module to the 
fallback state. When communications are restored, the I/O module restarts and may not operate 
as anticipated.

Connection parameters:

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not configure a holdup time value that is less than the recommended minimum value for 
standalone or Hot Standby systems:
 standalone systems:
 periodic application: 4.4 x PLC scan time
 cyclic application: configured watchdog value

 Hot Standby systems: configured watchdog value + PLC scan time
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Parameter Comment
Custom RPI Check this box to configure the CRA->CRP RPI value.

NOTE: The minimum CRA->CRP RPI value is 5 ms.

NOTE: Only change the CRA->CRP RPI value if you are using the IU_ERIO function 
block (see page 103).

CRA->CRP RPI Inputs: The RPI is the input refresh rate at which the adapter module sends inputs to the 
140CRP31200 module. The RPI is set in the subscribe field for the adapter on the remote 
I/O drop.
 periodic mode: default value = 1/2 MAST period
 cyclic mode: default value = 1/4 MAST watchdog timeout period
 valid values: 5...1500 (ms)

You can configure this value when Custom RPI is checked.
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NOTE: 
 When the Periodic mode is selected for the MAST task, the Period value allows the complete 

execution of the logic. (The MAST can overrun when its execution time exceeds this value.) 
Valid values: 1...255 ms (increment: 1 ms).

 When Cyclic mode is selected for the MAST task, the outputs are sent upon the completion of 
the task. The Watch Dog value (10 ... 1500 ms, default = 250) should be greater than the 
execution time. Valid values: 10...1500 ms (increment: 10 ms, default = 250 ms).

CRP->CRA RPI Outputs: Outputs are passed from the 140CRP31200 module to the adapter. Set the 
output refresh rate with the Application Trigger value (CRP->CRA RPI) at the end of the 
CPU MAST task:
 periodic mode: default value = 1.1 * MAST period. The value output is sent at the end 

of the actual MAST period.
 cyclic mode: default value = 1/4 * watchdog timeout period. The value output is sent at 

the end of the actual MAST period.

NOTE: The default value for the watchdog timer is 250 ms. If the MAST task does not 
finish within the watchdog period, the process times out. If the watchdog is greater than 4 
times the MAST period, the drops could switch to fallback while the CPU is running. For 
example, MAST period = 20 ms, logic execution = 90 ms, watchdog time = 100 ms.
You cannot edit this value. All outputs are published synchronously or at the execution of 
the MAST task:
 synchronously: immediately at the end of the MAST task
 execution of IU_ERIO: You can only generate outputs when you use the IU_ERIO 

function block (see page 103). (See the note below.)

Parameter Comment
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Device DDT Parameters

Device DDT Parameters (Remote I/O Drop)
This topic describes the Control Expert Device DDT tab for an Ethernet remote I/O drop that 
includes a 140CRA31200 or BMXCRA312•0 adapter module. A derived data type (DDT) is a set 
of elements with the same type (ARRAY) or with different types (structure).

The device DDT instance name can be defined manually but, when adding a module, a default 
device DDT instance name (see EcoStruxure™ Control Expert, Program Languages and 
Structure, Reference Manual) is defined by Control Expert
NOTE:
 These instructions assume that you have already added a drop to your Control Expert project 

(see page 53).
 Refer to the Derived Data Types chapter (see page 77) to create, update, and view derived data 

types.

Access the Device DDT Tab
Access the Device DDT parameters in Control Expert:

Example of the Implicit device DDT area which contains a name and a type.

Step Action Comment
1 Expand (+) EIO Bus in the Control 

Expert Project Browser
Path: Project Browser → EIO Bus → EIO 
Quantum Drop/EIO Modicon X80 Drop

2 Double-click on the EIO drop 
(Quantum or Modicon X80.

The EIO drop window appears. It contains the 
parameter tabs for the remote I/O drop.
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Parameters
Use the Control Expert Device DDT tab to configure these parameters for the adapter on the 
remote I/O rack:

Parameter Description
Implicit device DDT Name A default device DDT instance name (see EcoStruxure™ Control 

Expert, Program Languages and Structure, Reference Manual) is 
defined by Control Expert.

NOTE: 
 There are 2 device DDT types for Ethernet remote I/O drops in a 

Quantum system:
 140CRA31200 adapter: T_U_DROP_STD_IN
 BMXCRA312•0 adapter: T_M_DROP_EXT_IN

 There is 1 device DDT type for a Quantum Ethernet remote I/O drop 
in an M580 system:
 140CRA31200 adapter: T_Q_DROP_EXT_IN

Type module type (uneditable)
Goto details link to the DDT data editor screen
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Time Stamping

Time Stamp Module
Use these modules on an Ethernet remote I/O drop:
 Modicon X80 BMXCRA31210 adapter module with a BMX ERT 1604 time stamp module
 Quantum 140CRA31200 adapter module with a 140 ERT 1604 module
This sample rack configuration in Control Expert shows a Quantum EIO drop with the required 
140 ERT 1604 module:

Configuration
Double-click the BMX ERT 1604 in the remote rack to see the time stamp Configuration tab.

NOTE: For more information about time stamping with the BMXCRA31210 modules, refer to the 
BMXERT1604T M340 ERT Module User Manual.
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Section 3.4
Derived Data Types

Overview
This chapter describes how to complete your Control Expert project by creating, updating, and 
viewing derived data type (DDT) variables.

What Is in This Section?
This section contains the following topics:

Topic Page
Device DDT Names for the Quantum EIO Remote I/O Head Module 78
Device DDT Names for Quantum EIO Remote I/O Adapter Modules 83
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Device DDT Names for the Quantum EIO Remote I/O Head Module

Introduction
This topic describes the Control Expert Device DDT tab for a Quantum local rack that includes a 
140CRP31200 remote I/O head module. A derived data type (DDT) is a set of elements with the 
same type (ARRAY) or with different types (structure).

The device DDT instance name can be defined manually but, when adding a module, a default 
device DDT instance name (see EcoStruxure™ Control Expert, Program Languages and 
Structure, Reference Manual) is defined by Control Expert

Modifying a Device DDT name
In Control Expert a Device DDT name can be easily modified:

The Implicit device DDT field contains a default name and type.

Access the Device DDT Tab
In Control Expert:

Step Action Comment
1 Open Data Editor in the Control Expert 

Project Browser.
Path: Tools → Data Editor

2 Right click on the device DDT and use 
the Copy/Paste.

A new default name is proposed by default.

3 Expand Local Bus in the Control 
Expert Project Browser.

Path: Tools → Project Browser → Project → 
Configuration → Local Bus

4 Double-click the 140CRP31200 
module.

The parameter tabs appear.

5 Select the Device DDT tab. select the new DDT name (eg : My_CRP312) as the 
name of Device DDT.

Step Action Comment
1 Expand Local Bus in the Control Expert Project 

Browser.
Path: Tools → Project Browser → Project → 
Configuration → Local Bus

2 Double-click the 140CRP31200 module. The parameter tabs appear.
3 Select the Device DDT tab.
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Example of the Implicit device DDT area which contains a name and a type.

Parameters
Use the Control Expert Device DDT tab to configure parameters for the 140CRP31200 module on 
the local rack:

Implicit Device DDT Types
The 140CRP31200 module implements the implicit device DDT type in accordance with the CPU 
configuration:
 T_U_CRP_HSBY_IN: Hot Standby configurations
 T_U_CRP_STD_IN: standalone configurations

Hot Standby Configurations
This table describes the fields in the T_U_CRP_HSBY_IN implicit device DDT type that is used with 
the 140CRP31200 module in Hot Standby configurations:

Parameter Description
Implicit device DDT Name a default device DDT instance name (see EcoStruxure™ Control Expert, 

Program Languages and Structure, Reference Manual) is defined by 
Control Expert.

Type module type (uneditable)
Goto details link to the DDT data editor screen

Field Type Access Description
LOCAL_PLC T_U_CRP_STD_IN R 140CRP31200 status (local PLC)
REMOTE_PLC T_U_CRP_STD_IN R 140CRP31200 status (remote/peer PLC)
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Standalone and Hot Standby Configurations
This table describes the fields in the T_U_CRP_STD_IN implicit device DDT type that is used with 
the 140CRP31200 module in standalone and Hot Standby configurations.
ETH_STATUS (BYTE):

NOTE: You can monitor breaks in the remote I/O main ring by diagnosing the REDUNDAN-
CY_STATUS bits in the 140CRP31200 module DDT. The system detects and reports in this bit a 
main ring cable break that persists for at least 5 seconds.
Within the REDUNDANCY_STATUS bit:
 0: The cable is broken or the device is stopped.
 1: The loop is present and healthy.
In a Hot Standby system, perform a BITWISE OR operation of the REDUNDANCY_STATUS bit in 
the DDTs for both the primary and standby 140CRP31200 modules to determine whether a cable 
break has occurred. As indicated above, a value of 0 indicates a cable break; a value of 1 indicates 
no cable break.

Name Type Rank Bit Description
PORT1_LINK BOOL 0 0 0 = Port 1 link is down.

1 = Port 1 link is up.
PORT2_LINK BOOL 1 1 0 = Port 2 link is down.

1 = Port 2 link is up.
PORT3_LINK BOOL 2 2 0 = Port 3 link is down.

1 = Port 3 link is up.
PORT4_LINK BOOL 3 3 0 = Port 4 link is down.

1 = Port 4 link is up.
CRP_LINK BOOL 4 4 0 = CRP link is down.

1 = CRP link is up.
REDUNDANCY_STATUS BOOL 5 5 0 = Redundant owner is not present.

1 = Redundant owner is present.

NOTE: In Hot Standby systems, if this bit is set to 1 either in the local or remote 
140CRP31200 DDT then the main physical ring is OK. If this bit is set to 0 in both 
the local and remote 140CRP31200 DDTs, the main physical ring is broken.

SCANNER_OK BOOL 6 6 0 = Scanner is not present.
1 = Scanner is present.

GLOBAL_STATUS BOOL 7 7 0 = At least 1 service is not operating normally.
1 = All services are operating normally.
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SERVICE_STATUS (BYTE):

ETH_PORT_STATUS:

Name Type Rank Bit Description
RSTP_SERVICE BOOL 0 0 0 = RSTP service is not operating normally.

1 = RSTP service is operating normally or 
disabled.

PORT502_SERVICE BOOL 2 2 0 = Port 502 service is not operating normally.
1 = Port 502 service is operating normally or 
disabled.

SNMP_SERVICE BOOL 3 3 0 = SNMP service is not operating normally.
1 = SNMP service is operating normally or 
disabled.

IP_ADDRESS_STATUS BOOL 4 4 0 = IP address is a duplicate or unassigned.
1 = Assigned IP address is not a duplicate.

(reserved bits) — 5...7 5...7 —

Name Rank Bit Description
These combined 2-bit values indicate the conditions 
(WORD)

— 1/0 Ethernet port 1 function
— 3/2 Ethernet port 1 RSTP role
— 5/4 Ethernet port 2 function
— 7/6 Ethernet port 2 RSTP role
— 9/8 Ethernet port 3 function
— 11/10 Ethernet port 3 RSTP role
— 12/13 Ethernet port 4 function
— 14/15 Ethernet port 4 RSTP role

port function — 0 disabled
1 access port
2 port mirror
3 remote I/O network port

RSTP role — 0 unknown
1 alternate/backup
2 root
3 designated
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IN_BYTES:

IN_ERRORS:

OUT_BYTES:

OUT_ERRORS:

Type Rank Bit Description
UINT 4/5 — number of bytes (octets) received on interface

Type Rank Bit Description
UINT 6/7 — number of inbound packets that contain detected errors

Type Rank Bit Description
UINT 8/9 — number of bytes (octets) sent on interface

Type Rank Bit Description
UINT 10/11 — number of outbound packets that contain detected errors
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Device DDT Names for Quantum EIO Remote I/O Adapter Modules

Introduction
This topic describes the Control Expert Device DDT tab for an Ethernet remote I/O drop that 
includes a •••CRA312•0 adapter module.
The I/O structure type for the Quantum remote I/O drop is T_U_DROP_STD_IN. The I/O structure 
type for the Modicon X80 remote I/O drop is T_M_DROP_EXT_IN. In addition, when a remote I/O 
drop with a Quantum 140CRA31200 module is placed into an M580 system, the I/O structure type 
is T_Q_DROP_EXT_IN.
The device DDT instance name can be defined manually but, when adding a module, a default 
device DDT instance name (see EcoStruxure™ Control Expert, Program Languages and 
Structure, Reference Manual) is defined by Control Expert
NOTE: These instructions assume that you have already added a drop to your Control Expert 
project (see page 40).

Access the Device DDT Tab
In Control Expert:

Example of the Implicit device DDT area which contains a name and a type.

Step Action Comment
1 Expand EIO Bus in the Control Expert Project 

Browser to display the EIO drop (Quantum
Path: Tools → Project Browser → Project → 
Configuration → EIO Bus → EIO Quantum Drop

2 Double-click the EIO drop. The EIO drop window appears.
3 Select the Device DDT tab.
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Drop Parameters
Use the Control Expert Device DDT tab to configure these parameters for the Ethernet remote I/O 
drop:

Diagnostic Parameters
This table contains the DROP diagnostic parameters for the Ethernet remote I/O drop module:

Parameter Description
Implicit device DDT Name A default device DDT instance name (see EcoStruxure™ 

Control Expert, Program Languages and Structure, 
Reference Manual) is defined by Control Expert.

Type module type (uneditable)
Goto details link to the DDT data editor screen

Name Type Bit Description
IO_HEALTH_RACK1
only for T_Q_DROP_EXT_IN

WORD — Health bits of rack 1: slots 1 to 16

IO_HEALTH_RACK2
only for T_Q_DROP_EXT_IN

WORD — Health bits of rack 2: slots 1 to 16

DEVICE_NAME string[16] — device name of the remote I/O 
drop (see page 71)

VERSION WORD — firmware version (Maj, Min) (4 
digits coded in BCD)

ROTARY_SWITCHES BYTE — rotary switch value at power up
CRA_STATE BYTE — 1: CRA module is idle.

2: CRA module is stopped.
3: CRA module is running.

CRA_DIAGNOSTIC 
[WORD]

GLOBAL_IO_HEALTH BOOL 0 0: At least one I/O module in the 
drop reports bad health.

CCOTF_IN_PROGRESS BOOL 1 CCOTF is in progress.
CCOTF_INVALID_CONF BOOL 2 CCOTF configuration is not valid.
IOPL_MISMATCH BOOL 3 There is an output data mismatch. 

The modules in the rack are not the 
same as the modules configured in 
the PLC.

SWITCH_CHANGE BOOL 4 The rotary switches settings have 
changed since the last power up.

DROP_COM_HEALTH BOOL 5 This bit shows the drop 
communication health (set to 1 in 
remote I/O drop).
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CYCLE_CURR_TIME UINT — This word indicates the execution 
time of the last CRA cycle.
It has values between [0,65535] 
with a resolution of 0.01 ms, 
therefore, the last cycle time is 
between [0,655] ms.

CYCLE_MAX_TIME UINT — This word indicates the longest 
CRA cycle execution time since 
the last start.
It has values between [0,65535] 
with a resolution of 0.01 ms, 
therefore, the longest cycle time is 
between [0,655] ms.

CYCLE_MIN_TIME UINT — This word indicates the shortest 
CRA cycle execution time since 
the last start.
It has values between [0,65535] 
with a resolution of 0.01 ms, 
therefore, the shortest cycle time is 
between [0,655] ms.

TIME_STAMP_RECORDS
(Not used for 140CRA31200 applications.)

UINT — This word contains the number of 
Time Stamp records available in 
the drop local buffer.

TS_DIAGNOSTIC_FLAGS 
(WORD)
(BMXCRA312•0 only)

TIME_VALID BOOL 0 The time is valid and 
synchronized.

CLOCK_FAILURE BOOL 1 The time source of the sending 
device is not validated. The time 
stamp value is ignored.

CLOCK_NOT_SYNC BOOL 2 The time source of the sending 
device is not synchronized with the 
external UTC time.

BUFF_FULL BOOL 3 The buffer is full.
SOE_UNCERTAIN BOOL 7 The SOE (sequence of events) in 

the buffer is not known. The SOE is 
reset when the sequence of events 
is OK.

TS_BUF_FILLED_PCTAGE
(BMXCRA312•0 only)

BYTE — This byte reports the percentage of 
the buffer filled (0...100).

TS_EVENTS_STATE
(BMXCRA312•0 only)

BYTE — The byte reports the main state of 
TS events.

Name Type Bit Description
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ETH_STATUS (BYTE) PORT1_LINK BOOL 0 0 = Port 1 link is down.
1 = Port 1 link is up.

PORT2_LINK BOOL 1 0 = Port 2 link is down.
1 = Port 2 link is up.

PORT3_LINK BOOL 2 0 = Port 3 link is down.
1 = Port 3 link is up.

(reserved bit) — 3 —
RPI_CHANGE BOOL 4 RPI change: EtherNet/IP RPI 

change is in progress (during 
CCOTF).

REDUNDANCY_OWNER BOOL 6 0 = Redundant owner is not 
present.
1 = Redundant owner is present.

GLOBAL_STATUS BOOL 7 0 = At least 1 service is not 
operating normally.
1 = All services are operating 
normally.

SERVICE_STATUS 
(BYTE)

RSTP_SERVICE BOOL 8 0 = RSTP service is not operating 
normally.
1 = RSTP service is operating 
normally or disabled.

SNTP_SERVICE (reserved) BOOL 9 0 = SNTP service is not operating 
normally.
1 = SNTP service is operating 
normally or disabled.

PORT502_SERVICE BOOL 10 0 = Port 502 service is not 
operating normally.
1 = Port 502 service is operating 
normally or disabled.

SNMP_SERVICE BOOL 11 0 = SNMP service is not operating 
normally.
1 = SNMP service is operating 
normally or disabled.

(reserved bits) — 4...7 —

Name Type Bit Description
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ETH_PORT_STATUS 
(BYTE)

These combined 2-bit values 
indicate the conditions

WORD 1/0 Ethernet port 1 function
3/2 Ethernet port 1 RSTP role
5/4 Ethernet port 2 function
7/6 Ethernet port 2 RSTP role
9/8 Ethernet port 3 function
11/10 Ethernet port 3 RSTP role
12/13 Ethernet port 4 function
14/15 Ethernet port 4 RSTP role

port function — 0 disabled
1 access port
2 port mirror
3 remote I/O network port

RSTP role — 0 alternate
1 backup
2 designated
3 root

NTP_UPDATE (reserved) UINT — elapsed time (100 ms) since last 
update from NTP server

MAX_PACKET_INTERVAL UINT — maximum packet interval (ms) for 
output packets

IN_BYTES UINT — number of bytes (octets) received 
on interface

IN_ERRORS UINT — number of inbound packets that 
contain detected errors (In Errors)

OUT_BYTES UINT — number of bytes (octets) sent on 
interface

OUT_ERRORS UINT — number of outbound packets that 
contain detected errors (In Errors)

SOE_UNCERTAIN BOOL — The SOE (sequence of events) in 
the buffer is not known. The SOE is 
reset when the sequence of events 
is OK.

Name Type Bit Description
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Device DDT Types for I/O Modules
Refer to the following user guides for specific I/O module device DDT types:

I/O Module User Guide Reference
Modicon X80 discrete 
input/output

Modicon M340 Using EcoStruxure™ Control Expert Discrete Input/Output 
Modules User Manual

Modicon X80 analog 
input/output

Modicon M340 with EcoStruxure™ Control Expert Analog Input/Output 
Modules User Manual

BMX EHC 0800 Modicon M340 with EcoStruxure™ Control Expert Counting Module 
BMX EHC 0800 User Manual

BMX EHC 0200 Modicon M340 with EcoStruxure™ Control Expert Counting Module 
BMX EHC 0200 User Manual

BMX NOM 0200 Modicon M340 with EcoStruxure™ Control Expert Serial Link User Manual
BMX ERT 1604T BMX ERT 1604T M340 ERT Module User Manual
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Section 3.5
Elementary Functions (EFs) and Function Blocks (EFBs)

Using Quantum Function Blocks in M580 Systems

Supporting Quantum Configurations
M580 PLCs use these elementary functions (EFs) and elementary function blocks (EFBs) to 
support Quantum I/O configurations:

Function Block Quantum Family Description
ACI030 I/O management EFBs: Manage the I/O for Quantum ERIO 

modules.ACI040 I/O management
ACO020 I/O management
ACO130 I/O management
AII330 I/O management
AII33010 I/O management
AIO330 I/O management
AMM090 I/O management
ARI030 I/O management
ATI030 I/O management
AVI030 I/O management
AVO020 I/O management
ERT_854_10 I/O management
ERT_854_20 I/O management
ERT_854_30 I/O management
I_NORM_WARN analog I/O scaling EFBs: Scale analog values from Quantum analog 

modules.I_PHYS_WARN analog I/O scaling
I_SCALE_WARN analog I/O scaling
I_SET analog I/O scaling
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I_RAW analog I/O scaling EFs: Scale analog values from Quantum analog 
modules.I_RAWSIM analog I/O scaling

I_NORM analog I/O scaling
I_PHYS analog I/O scaling
I_SCALE analog I/O scaling
I_FILTER analog I/O scaling
O_NORM_WARN analog I/O scaling EFBs: Scale analog values from Quantum analog 

modules.O_PHYS_WARN analog I/O scaling
O_SCALE_WARN analog I/O scaling
O_SET analog I/O scaling
O_RAW analog I/O scaling EFs: Scale analog values from Quantum analog 

modules.O_NORM analog I/O scaling
O_PHYS analog I/O scaling
O_SCALE analog I/O scaling
O_FILTER analog I/O scaling
DROP I/O configuration EFBs: I/O configuration blocks for building data 

blocks for analog or ERT modules.XDROP I/O configuration

Function Block Quantum Family Description
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Section 3.6
Application Download

Downloading the Application to the PLC

Downloading the Application to the PLC
Download the Control Expert application to the PLC through one of its ports or through a 
connection to an Ethernet communication module:

Method Connection
USB port If the PLC and the PC that is running Control Expert both have USB ports, you can 

download the application to the PLC directly through the USB ports.
Modbus Plus port If the PLC and the PC that is running Control Expert both have Modbus Plus ports, 

you can download the application to the PLC directly through the Modbus Plus ports.
serial port If the PLC and the PC that is running Control Expert both have serial ports, you can 

download the application to the PLC directly through the serial ports.
Ethernet port If the PLC and the PC that is running Control Expert both have Ethernet ports, you 

can download the application to the PLC directly through the Ethernet ports.
communication 
module

You can download the application to the PLC by connecting Control Expert to the IP 
address of the communication module.

NOTE: You cannot download the application to the PLC with the 140CRP31200 module.
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Chapter 4
Explicit Messaging

Overview
EtherNet/IP uses the TCP/IP and UDP/IP protocols to implement both explicit and implicit 
messaging.
This chapter explains the 140CRP31200 remote I/O head module and its use of explicit messaging 
for request-and-reply communications for non-real-time information (like configuration and 
diagnostic data). A network node that receives a TCP/IP-encapsulated explicit message processes 
the message and generates a response.
NOTE: The 140CRP31200 module can process 16 MBP_MSTR blocks per MAST cycle.
NOTE: If you receive a detected error message — stating that the 140CRP31200 module does not 
have a link (has no cable), MSTR functionality may not be available. If this happens, check that 
your cables are connected properly.
This chapter describes how to use both Control Expert function block logic and the Control Expert 
interface to send explicit messages.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
4.1 EtherNet/IP Explicit Messaging Using MBP_MSTR 94
4.2 Explicit Messaging via the Control Expert GUI 100
4.3 Immediate I/O Access (IU_ERIO) 103
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EtherNet/IP Explicit Messaging Using MBP_MSTR

Section 4.1
EtherNet/IP Explicit Messaging Using MBP_MSTR

Introduction
This section shows you how to configure the MBP_MSTR function block for explicit messages.

NOTE: Use the 140CRP31200 module to send MBP_MSTR commands to diagnose the status of 
sub-rings. For other operations (get remote statistics, read data, etc.), we recommend that you 
send an MBP_MSTR command from a 140 NO• 7•• •• module.

What Is in This Section?
This section contains the following topics:

Topic Page
Supported MBP_MSTR Function Codes 95
EtherNet/IP Explicit Messaging Services 96
Configuring the CONTROL and DATABUF Parameters 98
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Supported MBP_MSTR Function Codes

Function Codes
We recommend using these MBP_MSTR function codes with the 140 CRP 312 00 module to 
diagnose sub-rings:

NOTE: The 140 CRP 312 00 module supports only 16 MBP_MSTR codes per CPU cycle.

MBP_MSTR Control 
Code

Description 140 CRP 312 00 
Support

0x00 0x0E EIP explicit message (connected) X (see page 96)
0x01 0x0E EIP explicit message (unconnected) X
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EtherNet/IP Explicit Messaging Services

Overview
Communication protocols:
 EtherNet/IP: The 140 CRP 312 00 module uses the EtherNet/IP protocol for all exchanges of 

I/O data.
 Modbus: The 140 CRP 312 00 module uses the Modbus/TCP protocol for reading diagnostics 

and for MBP_MSTR.
Every EtherNet/IP explicit message performs a service. Each service is associated with a service 
code (or number). You will need to identify the explicit messaging service by its name, decimal 
number, or hexadecimal number.
You can execute EtherNet/IP explicit messages using either a Control Expert MBP_MSTR function 
block or the Control Expert Ethernet Configuration Tool’s EtherNet/IP Explicit Message Window. 
(Refer to Explicit Messaging via the Control Expert GUI (see page 100).)
NOTE: Configuration edits made to an Ethernet communication module from the Control Expert 
Ethernet Configuration Tool’s EtherNet/IP Explicit Message Window are not saved to the operating 
parameters stored in the CPU and, therefore, are not sent by the CPU to the module on startup.
You can use Control Expert to construct a request that executes any service supported by the 
target device that is compliant with the EtherNet/IP protocol.

Services
The services supported by Control Expert include these standard explicit messaging services:

Service Code Description Available in...
Hex Dec MBP_MSTR 

block
Control Expert 
GUI

1 1 Get_Attributes_All X X
2 2 Set_Attributes_All X X
3 3 Get_Attribute_List X —
4 4 Set_Attribute_List X —
5 5 Reset X X
6 6 Start X X
7 7 Stop X X
8 8 Create X X
9 9 Delete X X
A 10 Multiple_Service_Packet X —
D 13 Apply_Attributes X X
x (available service)
— (service not available)
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E 14 Get_Attribute_Single X X
10 16 Set_Attribute_Single X X
11 17 Find_Next_Object_Instance X X
14 20 Error Response (DeviceNet only) — —
15 21 Restore X X
16 22 Save X X
17 23 No Operation (NOP) X X
18 24 Get_Member X X
19 25 Set_Member X X
1A 26 Insert_Member X X
1B 27 Remove_Member X X
1C 28 GroupSync X —

Service Code Description Available in...
Hex Dec MBP_MSTR 

block
Control Expert 
GUI

x (available service)
— (service not available)
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Configuring the CONTROL and DATABUF Parameters

Overview
The CONTROL and DATABUF output parameters define the operations of the MBP_MSTR 
function block. For the EtherNet/IP protocol, the structure of the CONTROL and DATABUF output 
parameters remains the same for all explicit messaging services.

Configuring the Control Parameter
Use MSTR operation 14 or 270 to send generic Modbus requests on the network. (These operation 
codes are not available on the Modbus Plus port or embedded Ethernet port on the CPU.)
The CONTROL parameter register contains these consecutive words:

Register Function Description
CONTROL[0] operation  14 = unconnected

 270 = connected

CONTROL[1] detected error 
status

Holds the event code (read-only).

CONTROL[2] data buffer length Data buffer length, in words

CONTROL[3] response offset Offset for the beginning of the response in the data buffer, in 16-bit words
Note: To avoid overwriting the request, make the response offset value 
greater than the request length CONTROL[10].

CONTROL[4] routing register Specify a network destination node during data transfer:
 MSB: The most significant byte contains the source node address (for 

example, the slot number of the 140 NOE 771 •• or 140CRP31200 
module). Exception: The value of the integrated Ethernet port on the 
CPU is 254 (FE h) regardless of the CPU slot number. Note: Only 1 
Ethernet 140CRP31200 module can be used.

 LSB: The least significant byte contains the destination node address 
(for example, MBP on the Ethernet Transporter (MET) mapping index 
for the 140 NOE 771 •• or the drop number for the 140CRP31200).

CONTROL [5]1 IP address Each address contains 1 byte of the 32-bit IP address:
 high byte = byte 4 of the IP address (MSB)
 low byte = byte 3 of the IP address
 high byte = byte 2 of the IP address
 low byte = byte 1 of the IP address (LSB)

CONTROL [6]1

CONTROL[7] request length length of the CIP request, in bytes

CONTROL[8] response length length of the response received, in bytes
read only—set after completion

1. For example, the Control parameter handles the IP address 192.168.1.6 in the following order: Byte 4 = 192,  
Byte 3 = 168, Byte 2 = 1, Byte 1 = 6. 
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Configuring the Data Buffer
The DATABUF varies in size. It consists of contiguous registers that include—in sequence—both 
the CIP request and the CIP response. To avoid overwriting the request, confirm that the data 
buffer is large enough to contain both the request and response data. 

The formats of the data buffer’s CIP request and CIP response are described in this table. (Both 
the request and response are structured in little endian order.)

Data Buffer:
Variable size: set in CONTROL[2]

CIP Request:
Request size: set in CONTROL[7] 

CIP Response:
Starting position: set in CONTROL[3] 
Response size: reported in CONTROL[8] 

NOTE: If the response offset is smaller than the request size, 
response data overwrites part of the request.

Request
Byte offset Field Data Type Description
0 Service Byte Service of the explicit message
1 Request_Path_Size Byte The number of words in the Request_Path field
2 Request_Path Padded EPATH This byte array describes the path of the request (including 

class ID, instance ID, etc.) for this transaction.
... Request_Data Byte array Service-specific data in the explicit message request 

delivery (if none, this field is empty)
Response
Byte offset Field Data Type Description
0 Reply Service Byte Service of the explicit message + 16#80
1 Reserved Byte 0
2 General Status Byte EtherNet/IP General Status
3 Size of Additional 

Status
Byte Additional Status array size—in words

4 Additional Status Word array Additional status
... Response Data Byte array Response data from request, or additional detected error 

data if General Status indicates a detected error
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Explicit Messaging via the Control Expert GUI

Section 4.2
Explicit Messaging via the Control Expert GUI

Sending Explicit Messages to EtherNet/IP Devices

Introduction
The 140 CRP 312 00 module uses explicit messages from Control Expert to obtain diagnostics 
information from an EtherNet/IP module or device on the network.

Access the EtherNet/IP Explicit Message Window

Step Action Comment
1 Access the 140 CRP 312 00 module for Online Action. Refer to the Devices Services tab 

(see page 171).
2 Double-click the 140 CRP 312 00 module in the 

Control Expert rack view.
The EtherNet/IP Explicit Message tab 
appears.
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The EtherNet/IP Explicit Message Tab
The EtherNet/IP Explicit Message window shows an example of the configuration of an 
EtherNet/IP explicit message and the response to the message. The explicit message is 
addressed to a DRS to obtain diagnostic information:

Parameters
Features of the EtherNet/IP Explicit Message screen:

Field Parameter (Value) Description
Address

NOTE: Refer to your 
EtherNet/IP device user 
manual for the values in the 
Address field.

IP Address
(x.x.x.x)

The IP address of the target device, used to identify the target 
of the explicit message. (The IP address in the example above 
is 192.168.1.6.)

Class
(1...65535)

The class identifier of the target device is an integer that is 
used to construct the message path. (The class in the example 
above is 4.)

Instance
(0...65535)

The class instance of the target device is an integer that is 
used to construct the message path. (The class instance in the 
above example is 100.)

Attribute
(0...65535)

The specific device attribute (or property) is the target of the 
explicit message. This integer is used to construct the 
message path. (The attribute in the above example is 3.)

NOTE: Check this box to enable this optional field.
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NOTE: You can use explicit messaging to perform many different services, but every EtherNet/IP 
device does not support every service.

Service Number
(1...127)

Number is an integer that is associated with the service that the 
explicit message performs.

NOTE: If you select Custom Service, type in a service 
number. This field is read-only for all other services.

Name Scroll to the name of the service that you want the explicit 
message to perform. In the example above, 
Get_Attribute_Single is selected.

Enter Path (hex) Check this box to enable the message path field where you can 
manually enter the entire path to the target device. (In the 
example above, the box is not checked.)

Data (hex) — The Data field contains the data to be sent to the target device 
for services that send data. (The field is blank in the example 
above.)

Messaging Connected Select the type of explicit message to send:
 unconnected: An unconnected message requires path 

information (addressing) that identifies the destination 
device and (optionally) device attributes.

 connected: A connected explicit message contains path 
information and a connection identifier to the target device.

NOTE: The example uses an Unconnected message.

Unconnected

Send to Device (button) — After the explicit message is configured, press Send to Device.
Response (hex) — Response contains the (hexadecimal) data sent to the 

configuration by the target device when you press Send to 
Device.

Status — After you press Send to Device, the messages in the Status 
field indicate the status of the explicit message.

Repeat (500ms) — Check this box to send the explicit message every 500 ms. (In 
this example, leave this blank.)

Field Parameter (Value) Description
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Immediate I/O Access (IU_ERIO)

Section 4.3
Immediate I/O Access (IU_ERIO)

Description

Function Description

An IU_ERIO function block updates Ethernet remote I/O drop input and output modules with an 
optimal response time. The Ethernet remote I/O drop inputs and outputs are updated during the 
MAST task.
Call this function block in a MAST task. It can be called more than once in a task.
NOTE: To maintain system performance, we recommend that you use no more than 10 executions 
of the IU_ERIO block during a single MAST task.
The input and output modules are physically located on an Ethernet remote I/O drop and declared 
in the Ethernet configuration.
EN and ENO can be configured as additional parameters.

NOTE: Refer to the Quantum EIO System Planning Guide for calculating the ART when your 
application does not use an IU_ERIO function block.

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not use the IU_ERIO function block in Quantum Hot Standby installations.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
S1A48978 12/2018 103



Explicit Messaging
IU_ERIO Mechanism
The Ethernet remote I/O drop input values are read in the 140CRP31200 module with an optimal 
response time.
The input values read in the 140CRP31200 module represent the latest values sent in an 
asynchronous way by the adapter module in each drop. The maximum time shift between values 
read in the 140CRP31200 and actual input values depends on the adapter’s publishing frequency 
(subscribe field CRA-> RPI) (see page 71).
The following diagram represents the I/O exchanges between a CPU and the Ethernet remote I/O 
drops:
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Representation in FBD
Representation:

Representation in LD
Representation:

Representation in IL
CAL IU_ERIO(DROP:=>Drop_Number, DIR:=>Input_Output, STATUS=>Status_Repo
rt);

Representation in ST
IU_ERIO(DROP:=>Drop_Number, DIR:=>Input_Output, STATUS=>Status_Report);
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Parameter Description
Input parameters:

Output parameter:

NOTE: If no connection is opened with the Ethernet remote I/O drop, a detected communication 
error (system words %SW172 to %SW173) is returned.

Parameter Data type Meaning
Drop INT Drop number (1...31)

Drop number:
 1: Drop 1
 2: Drop 2
 ...
 31: Drop 31

Dir BOOL Data direction:
 0 = Outputs. The output values are sent 

immediately to the 140CRP31200 module.
 1 = Inputs. The input values are read 

immediately from the 140CRP31200 module.

Parameter Data type Meaning
Status WORD Status report from the 140CRP31200 module:

 0002 hex: Invalid drop number
 0003 hex: Ethernet remote I/O drop is not 

configured
 0004 hex: Ethernet remote I/O drop is not 

connected
 0005 hex: Retry number is exceeded
 0007 hex: An error is detected on the 

140CRP31200 module
 0008 hex: Operation was not completed before 

time out
 0009 hex: 140CRP31200 module is not present 

on the local drop
 000B hex: Operation OK
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Chapter 5
Implicit Messaging

The MAST Task in Implicit Exchanges

Task Management
This topic explains implicit messaging and the relationship between the MAST task configuration 
and the remote I/O implicit exchanges.
Implicit messaging maintains open connections for real-time communications of a predefined 
nature between consumers and producers. Implicit messages contain control data and a 
connection identifier. 
EtherNet/IP uses the TCP/IP and UDP/IP protocols to implement both explicit and implicit 
messaging.

Access the MAST Configuration
View the Properties of MAST:

CIP Definitions
Inputs: The MAST period should be 2 times the RPI of the 140CRA31200 or BMXCRA312•0 
adapter on the remote I/O drop. This provides new input values for every MAST cycle. (For 
example, an RPI of 25 ms provides data for a MAST period of 50 ms.)
Outputs: The CPU in the local rack of a Quantum Ethernet I/O system produces outputs to Ethernet 
remote I/O drops and consumes inputs from those drops (based on the producer/consumer 
model). A consumer (the remote drop) detects the lack of updated data through a time-out. 
(Possible time-out values are N x RPI, where N = 4, 8, 16 ....) When a time-out is triggered, the 
consumer assumes that the producer is absent.

Periodic and Cyclic Modes
The effect that periodic and cyclic modes have on implicit messages is explained in the description 
of the connection parameters (see page 71).

Step Action
1 Go to the Properties of MAST dialog box in Control Expert (Tools → Project 

Browser → Project → Program → Tasks → MAST).
2 Right-click Properties.
3 Configure the parameters.
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Quantum I/O Management for Implicit I/O Exchanges
Assign state RAM addresses:

Drop type Instruction
Quantum Ethernet 
remote I/O

The direct state RAM address manages the Quantum I/O data.
Assign the state RAM addresses for each module. (Default values are proposed 
by Control Expert in the module configuration windows.) You can also define 
symbols on the I/O variables allocated in the state RAM.

Modicon X80 Ethernet 
remote I/O

To assign state RAM addresses for Modicon X80 I/O data, refer to the topic 
Device DDT Names for Quantum EIO adapters (see page 83)
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Chapter 6
Diagnostics

Overview
This chapter describes the diagnostics for the Quantum EIO modules. For details on diagnostics 
at the system level, refer to the systems diagnostics topic in the Quantum Ethernet I/O System 
Planning Guide.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
6.1 LED Indicators 110
6.2 Service Port Management 116
6.3 Diagnostics Available through the CPU 119
6.4 Diagnostics Available through Modbus/TCP 124
6.5 Diagnostics Available through EtherNet/IP CIP Objects 134
6.6 Diagnostics Available through Control Expert 170
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LED Indicators

Section 6.1
LED Indicators

What Is in This Section?
This section contains the following topics:

Topic Page
LED Indicators on the 140 CRP 312 00 Module 111
LED Indicators on the Quantum EIO Adapter Module 114
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LED Indicators on the 140 CRP 312 00 Module

Display
These LEDs are on the front of the 140CRP31200 module:

Indications
LED conditions:

Description Active Ready Mod Status Net Status
green green red green red green

general component not operating — off on off — —
invalid configuration — off flash off — —
not configured — off off flash — —
configured on blink off on off on/flash
no/default module MAC — blink 2 flash off off off
no/default port MAC — blink 2 flash off off off

power-up 
sequence

sequence 5 6 2 1 4 3
non-ODVA standard blink  

(.25 sec 
on; .25 sec 
off)

blink  
(.25 sec 
on; .25 sec 
off)

— — — —

ODVA standard — — blink  
(.25 sec 
on; .25 sec 
off)

blink  
(.25 sec 
on; .25 sec 
off)

blink  
(.25 sec 
on; .25 sec 
off)

blink  
(.25 sec 
on; .25 sec 
off)
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NOTE: In Hot Standby systems, the Net Status LEDs on the 140 CRP 312 00 modules are solid 
green during normal operations. When power to the 140 CRP 312 00 module in either rack A or B 
is lost, the Net Status LED on the 140 CRP 312 00 module in the partner rack is unchanged (solid 
green).

FDR client no Ethernet connections — blink 3 — — — —
duplicate IP — blink 4 off on on off
waiting for IP — blink 5 off on off off
default IP — blink 6 off on off off
receive or assign IP — on off on off flash
invalid configuration — blink 7 off on off off

EIP scanner no EIP connection or all 
EIP connections closed

— on flash off off flash

one or more connections 
established

— on off on off on

one connection timeout — on off on flash off

Description Active Ready Mod Status Net Status
green green red green red green
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Ethernet Port Indications

These LEDs report the status of the Ethernet port:

Name Color Status Description
LINK green on 100 Mbps link detected

yellow on 10 Mbps link detected
— off no detected link

ACT green blinking active Ethernet link (transmit or receive)
— off inactive Ethernet link
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LED Indicators on the Quantum EIO Adapter Module

Display
The LEDs are on the front of the adapter module:
140CRA31200:

BMXCRA312•0:

Indications
LED conditions:

Description Run IO Mod Status Net Status
green red green red green red

power-up 
sequence

blink (.25 sec on; .25 sec 
off)

1 2 Green/Red/Green Green/Red/Off

not configured IP address not valid — — flashing off off off
 valid IP address
 invalid configuration

off off flashing off flashing off

configured no external error detected flashing off — — flashing off
external error detected flashing on — — flashing off

I/O data 
communication 
established

STOP flashing (note 1) on off on off
RUN on (note 2) on off on off
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Ethernet Port Indications

These LEDs report the status of the Ethernet port:

detected error 
states

recoverable error — — off flashing — —
nonrecoverable error flashing on off on — —
duplicate IP address — — — — off on

OS firmware update flashing off off on off on
NOTE 1 (STOP state):
 on: An input or output is a detected error that originates in a module, or a channel configuration or a channel 

configuration error has been detected.
 off: Operations are normal.

NOTE 2 (RUN state):
 on: External error is detected.
 off: External error is not detected.

Description Run IO Mod Status Net Status
green red green red green red

Name Color Status Description
LINK green on 100 Mbps link detected

yellow on 10 Mbps link detected
— off no detected link

ACT green blinking active Ethernet link (transmit or receive)
— off inactive Ethernet link
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Service Port Management

Section 6.2
Service Port Management

What Is in This Section?
This section contains the following topics:

Topic Page
Service Port Configuration 117
Service Port Configuration for Adapter Modules 118
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Service Port Configuration

Introduction
The 140CRP31200 remote I/O head module and the remote I/O adapter modules (140CRA31200 
and BMXCRA31210) support the configuration of the SERVICE port without requiring you to re-
build or download your application.

140CRP31200
The online configuration of the SERVICE port on the 140CRP31200 module is discussed in the 
section about diagnostics through Control Expert (see page 173).

Adapter Modules
You can send explicit messages with an EtherNet/IP tool for the configuration of the SERVICE port 
on the 140CRA31200 or BMXCRA31210 modules. For details, refer to the discussions of 
EtherNet/IP CIP objects (see page 168) and SERVICE port configuration for adapter modules 
(see page 118).

Cycling Power
The online configuration of the SERVICE port is volatile. The following situations can arise when 
power is cycled to the module while the application is being applied:
 The configuration can be lost.
 The configuration in the application can be applied to the SERVICE port.
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Service Port Configuration for Adapter Modules

Configuration
Follow these steps to modify the Service Port configuration of an online 140CRA31200 or 
BMXCRA312•0 adapter module:

Port Mirroring: Use these steps only if you chose 2 (port mirroring) for the Port Control value 
(above):

Step Action
1 Launch the EtherNet/IP Explicit Message window (see page 100).
2 Assign these Device Services parameters:

 Address:
 IP Address: Enter the IP address of the adapter with the SERVICE port you want to configure.
 Class: 0x400
 Instance: 1

 Service:
 Name: Set_Attribute_Single

3 Set the Port Control value:
 Attribute: Check this box.
 Attribute (field): Enter 1 (access port).
 Data (hex) (field): Enter a value that is based on the Port Control attribute definition 

(see page 168).
NOTE: 
 To set the UINT value of 2, set the data field to 02 00 (low byte/high byte).
 If you enter 2 (port mirroring) in Attribute, refer to the next table.
 In port mirroring mode, the SERVICE port acts like a read-only port. That is, you cannot access 

devices (ping, connection to Control Expert, etc.) through the SERVICE port.
4 Leave the default values for these parameters:

 Enter Path(hex): Leave this check box unselected.
 Repeat(500ms): Leave this check this check box unselected.
 Messaging: Select Unconnected.

5 Press Send to Device.

Step Action
1 Set the Port Control value:

 Attribute: Check this box.
 Attribute: Enter 2 (port mirroring).
 Data(hex): Enter a value that is based on the Port Control attribute definition (see page 168).

2 Accept the default values for other parameters (as before).
3 Press Send to Device.
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Diagnostics Available through the CPU

Section 6.3
Diagnostics Available through the CPU

What Is in This Section?
This section contains the following topics:

Topic Page
System Diagnostics 120
Device Data Types for the Remote I/O Modules 123
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System Diagnostics

Introduction
System diagnostics are performed locally on the CPU with system bits (%S) and system words 
(%SW).

Local Rack Diagnostics
Local rack diagnostics are accessible for the 140CRP31200, 140 NOC 771 ••, and 
140 NOE 771 •• modules within the standard system bits (%SW180 to %SW339).

Ethernet Remote I/O Drop Diagnostics
Ethernet remote I/O drop diagnostics are accessible for the entire drop within system bits and 
words in the PLC (%S, %SW). Each drop is animated with a health bit display of the health bit 
status for:
 a drop node
 a module in a remote drop
The Quantum PLC on the local rack monitors remote I/O drops and module health. The 
140CRA31200 or BMXCRA312•0 adapter module on the remote I/O drop transmits detected 
errors in drop modules to the Quantum PLC via implicit exchanges (see page 134). The detected 
errors are stored in the global diagnostic buffers of the PLC and in the diagnostic buffer of the 
individual drop module.
The Quantum PLC or the 140CRP31200 module on the local rack updates the detected error 
buffers. Health bits are updated in the PLC only if the adapter of the concerned drop communicates 
with the 140CRP31200 module on the local rack. If these modules cannot communicate, the 
concerned health bits are set to 0.

System Bits and Words
This table describes new or modified system bits and words that represent detected errors:

System Bits/Words Symbol Description
%S117 EIOERR detected remote I/O error on the Ethernet I/O network
%SW101 EIO_CCOTF_COUNT EIO CCOTF counting status register
%SW108 FORCED_DISCRETE_COUNT forced bit counting status register
%SW109 FORCED_ANALOG_COUNT forced bit counting status register
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NOTE: Refer to Quantum-Specific System Words section (see EcoStruxure™ Control Expert, 
System Bits and Words, Reference Manual) for a detailed explanation.

Viewing Diagnostics in Control Expert
The bus editor in Control Expert uses color animation to display the status of each drop, rack, or 
module on the EIO Bus. The slot number of the drop/rack/module appears in red when a detected 
error is associated with that slot. For a module, the red display indicates the module is missing, 
inoperable, or improperly configured.

NOTE: 
Remember that the 16 slots have different numbering schemes:
 140CRA31200 drop: slots 1...16
 BMXCRA312•0 drop: slots 0...15

%SW152 ... %SW153 EIO_DROP_ERROR detected Ethernet remote I/O drop status
The bit is set to 0 if at least one I/O module in the drop 
as a detected error.
The bit is set to 1 if all modules are operating properly.
 %SW152.0: drop #1
 %SW152.1: drop #2
 ........
 %SW153.14: drop #31

%SW172 ... %SW175 EIO_CONNECT_STATUS Ethernet I/O communication health status for drops in 
standalone and primary systems

%SW176 ... %SW179 SDBY_EIO_CONNECT_STATUS Ethernet I/O communication health status for drops in 
standby systems

%SW180 ... %SW181 IOHEALTHij
(i = 1 ... 32, j = 1 ... 5)

health bits of the PLC modules (including Hot Standby 
and Safety Hot Standby systems)%SW182 ... %SW183

%SW641 ... %SW702 EIO_MOD_HEALTH Ethernet remote I/O module health bit status

System Bits/Words Symbol Description

Drop Status Language Object i j
drop (d) %SWi.j 152 + [(d-1)/16] (d-1)/16

140 CRA rack (r), drop (d) %SWi 641 + [(d-1)*2] + (r-1)
module (m), rack (r), 
drop (d)

%SWi.j 641 + [(d-1)*2] + (r-1) 16-m

BMX CRA rack (r), drop (d) %SWi 641 + [(d-1)*2] + r
module (m), rack (r), 
drop (d)

%SWi.j 641 + [(d-1)*2] + r 15-m
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NOTE: 
Remember that the rack numbering scheme is also different:
 140CRA31200 drop: 1 or 2
 BMXCRA312•0 drop: 0 or 1
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Device Data Types for the Remote I/O Modules

Device Data Types
The DDT structures for these remote I/O modules are described elsewhere:
 140CRP31200 head module (local rack)
 140CRA31200 or BMXCRA312•0 adapter (remote drop)
These DDTs are available in the application. Refer to the Derived Data Types section 
(see page 77).
The DDT diagnostics data is mapped to default local variables. The data is updated every MAST 
cycle.
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Diagnostics Available through Modbus/TCP

Section 6.4
Diagnostics Available through Modbus/TCP

Modbus Diagnostic Codes

Supported Diagnostic Codes
Modbus function code 3 provides access to a variety of diagnostic functions, including basic 
network diagnostics, Ethernet port diagnostics, and Modbus port 502 diagnostics. 
To access the function code 3 diagnostics from the local device, set the unit ID to 100.
The following modules support these Modbus diagnostic codes.
 Quantum remote I/O head module (140CRP31200)
 Quantum distributed I/O head module (140NOC78000)
 Quantum control head module (140NOC78100)
 Quantum remote I/O adapter module (140CRA31200)
 M340 distributed I/O head module (BMXNOC0401)
 M340 remote I/O adapter module (BMXCRA31200)
 Quantum IEC 61850 module (140NOP85000)
 M580 communications module (BMENOC03•1)
 M580 communications module (BMENOP0300)

Modbus Function Code 3: Basic Network Diagnostics
Basic network diagnostics start at address 40001(decimal) as described in the following table.

Starting 
Address 
(Decimal)

Length 
(Words)

Register Byte Order Comments
MS BYTE LS BYTE

40001 2 MS Byte 00 Byte 01 Basic network diagnostic validity
Byte 02 LS Byte

40003 1 MS Byte LS Byte 03 Communication global status
40004 1 MS Byte LS Byte Supported communication services
40005 1 MS Byte LS Byte Status of communication services
40006 2 IP 1 IP 2 IP address (IP1.IP2.IP3.IP4)

IP 3 IP 4
40008 2 SM 1 SM 2 Subnet mask (SM1.SM2.SM3.SM4)

SM 3 SM 4
124 S1A48978 12/2018



Diagnostics
40010 2 GW 1 GW 2 Default gateway (GW1.GW2.GW3.GW4)
GW 3 GW 4

40012 3 MAC 1 MAC 2 MAC address 
(MAC1:MAC2:MAC3:MAC4:MAC5:MAC6.MAC 3 MAC 4

MAC 5 MAC 6
40015 3 MS Byte 00 01 Ether frame format capability / configuration / 

operational02 03
04 LS Byte 05

40018 2 C00 C01 Ethernet receive frames OK
C02 C03

40020 2 C00 C01 Ethernet transmit frames OK
C02 C03

40022 1 MS Byte LS Byte Number of open client connections
40023 1 MS Byte LS Byte Number of open server connections
40024 2 C00 C01 Number of Modbus detected error messages sent

C02 C03
40026 2 C00 C01 Number of Modbus messages sent

C02 C03
40028 2 C00 C01 Number of Modbus messages received

C02 C03
40030 8 Char 1 Char 2 Device name

Char 3 Char 4
Char 5 Char 6
Char 7 Char 8
Char 9 Char 10
Char 11 Char 12
Char 13 Char 14
Char 15 Char 16

40038 2 MS Byte 00 Byte 01 IP assignment mode capability / operational
Byte 02 LS Byte 03

Starting 
Address 
(Decimal)

Length 
(Words)

Register Byte Order Comments
MS BYTE LS BYTE
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Example: Reading Basic Network Diagnostics with Modbus Function Code 3
Here is an example of how to read registers 40018 and 40019, the Ethernet receive frames OK 
count registers. The request contains 7 bytes. The starting address, shown as a hex value in byte 
2 below, is calculated as follows:
40018 – 40001 = 17 dec = (11 hex)
The number of registers to be diagnosed (2 hex) is shown in byte 4:

The normal response is returned in 8 bytes. In this example, the expected response is 14229 hex; 
this value is shown in bytes 2 through 5 of the response:

For more information on Modbus function code 3 and other function codes, refer to the Modicon 
Modbus Protocol Reference Guide (PI-MBUS-300).

Byte Number Value
0 Function code = 03 (hex)
1 Starting Address Hi = 00 (hex)
2 Starting Address Low = 11 (hex)
3 No. of Registers Hi = 00 (hex)
4 No. of Registers Low = 2 (hex)
5 CRC high byte (inserted by the Modbus sending application)
6 CRC low byte (inserted by the Modbus sending application)

Byte Number Value
0 Function code = 03 (hex)
1 Byte count = 4 (hex)
2 1st register data, high byte = 00 (hex)
3 1st register data, low byte = 01 (01 hex)
4 2nd register data, high byte = 42 (hex)
5 2nd register data, low byte = 29 (hex)
6 CRC high byte
7 CRC low byte

Byte Number Value
0 Original function code + 80 hex (= 83 hex)
1 Detected error code
2 CRC high byte
3 CRC low byte
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Modbus Function Code 3: Ethernet Internal Port Diagnostic Data
Internal port diagnostics start at address 40040 (decimal) as described in the following table.

Starting 
Address 
(Decimal)

Length 
(Words)

Register Byte Order Comments
MS BYTE LS BYTE

40040 1 MS Byte LS Byte Internal port Diagnostics Data Validity
40041 1 MS Byte LS Byte Internal port Logical/Physical Port Number
40042 1 MS Byte LS Byte Internal port Ethernet Control Capability
40043 1 MS Byte LS Byte Internal port Link Speed Capability
40044 1 MS Byte LS Byte Internal port Ethernet Control Configuration
40045 1 MS Byte LS Byte Internal port Link Speed Configuration
40046 1 MS Byte LS Byte Internal port Ethernet Control Operational
40047 1 MS Byte LS Byte Internal port Link Speed Operational
40048 3 MAC 1 MAC 2 MAC Address (MAC1:MAC2:MAC3:MAC4:MAC5:MAC6)

MAC 3 MAC 4
MAC 5 MAC 6

40051 2 MSB C00 C01 Internal port Media Counters Data Validity
C02 LSB C03

40053 2 MSB C00 C01 Internal port Num Frames Transmitted OK
C02 LSB C03

40055 2 MSB C00 C01 Internal port Num Frames Received OK
C02 LSB C03

40057 2 MSB C00 C01 Internal port Num Ether Collisions
C02 LSB C03

40059 2 MSB C00 C01 Internal port Carrier Sense Errors detected
C02 LSB C03

40061 2 MSB C00 C01 Internal port Num Ether Excessive Collisions
C02 LSB C03

40063 2 MSB C00 C01 Internal port CRC Errors detected
C02 LSB C03

40065 2 MSB C00 C01 Internal port FCS Errors detected
C02 LSB C03

40067 2 MSB C00 C01 Internal port Alignment Errors detected
C02 LSB C03

40069 2 MSB C00 C01 Internal port Num Internal MAC Tx Errors detected
C02 LSB C03
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40071 2 MSB C00 C01 Internal port Late Collisions
C02 LSB C03

40073 2 MSB C00 C01 Internal port Num Internal MAC Rx Errors detected
C02 LSB C03

40075 2 MSB C00 C01 Internal port Multiple Collisions
C02 LSB C03

40077 2 MSB C00 C01 Internal port Single Collisions
C02 LSB C03

40079 2 MSB C00 C01 Internal port Deferred Transmissions
C02 LSB C03

40081 2 MSB C00 C01 Internal port Frames Too Long
C02 LSB C03

40083 2 MSB C00 C01 Internal port Frames Too Short
C02 LSB C03

40085 2 MSB C00 C01 Internal port SQE Test Error detected
C02 LSB C03

40087 1 MS Byte LS Byte Internal port Interface Label Length
40088 32 IL char64 IL char63 Internal port Interface Label characters
40089 IL char62 IL char61
... ... ...
40118 IL char04 IL char03
40119 IL char02 IL char01
40120 1 MS Byte LS Byte Internal port Interface Counters Diagnostic Validity
40121 2 MSB C00 C01 Internal port Num Octets Received

C02 LSB C03
40123 2 MSB C00 C01 Internal port Num Unicast Packets Received

C02 LSB C03
40125 2 MSB C00 C01 Internal port Num Non Unicast Packets Received

C02 LSB C03
40127 2 MSB C00 C01 Internal port Num Inbound Packets Discarded

C02 LSB C03
40129 2 MSB C00 C01 Internal port Num Inbound Packets Error detected

C02 LSB C03

Starting 
Address 
(Decimal)

Length 
(Words)

Register Byte Order Comments
MS BYTE LS BYTE
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Modbus Function Code 3: Ethernet Port 1 Diagnostic Data
Port 1 diagnostics start at address 40143 (decimal). As described in the following table, port 1 
diagnostic data fields are the same as for the internal port, with the appropriate starting address 
offset.

401331 2 MSB C00 C01 Internal port Num Inbound Packets Unknown
C02 LSB C03

40133 2 MSB C00 C01 Internal port Num Octets Sent
C02 LSB C03

40135 2 MSB C00 C01 Internal port Num Unicast Packets Sent
C02 LSB C03

40137 2 MSB C00 C01 Internal port Num Non Unicast Packets Sent
C02 LSB C03

40139 2 MSB C00 C01 Internal port Num Outbound Packets Discarded
C02 LSB C03

40141 2 MSB C00 C01 Internal port Num Outbound Packets Error detected
C02 LSB C03

Starting 
Address 
(Decimal)

Length 
(Words)

Register Byte Order Comments
MS BYTE LS BYTE

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40143 1 MS Byte LS Byte Port 1 Port Diagnostics Data Validity
... ... ... ... ...
40244 2 MSB C00 C01 Port 1 Num Outbound Packets Error detected

C02 LSB C02
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Modbus Function Code 3: Ethernet Backplane Port Diagnostic Data
Backplane port diagnostics start at address 40246 (decimal). As described in the following table, 
backplane port diagnostic data fields are the same as for the internal port and port 1, with the 
appropriate starting address offset.

Modbus Function Code 3: Ethernet Port 3 Diagnostic Data
Port 3 diagnostics start at address 40349 (decimal). As described in the following table, port 3 
diagnostic data fields are the same as for the internal port and ports 1 and 2, with the appropriate 
starting address offset.

Modbus Function Code 3: Ethernet Port 4 Diagnostic Data
Port 4 diagnostics start at address 40452 (decimal).As described in the following table, port 4 
diagnostic data fields are the same as for the internal port and ports 1-3, with the appropriate 
starting address offset.

Ethernet Port Not Present
If an Ethernet port is not physically present on the device, the relevant Modbus registers will return 
data = 0.

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40246 1 MS Byte LS Byte Backplane Port Diagnostics Data Validity
... ... ... ... ...
40347 2 MSB C00 C01 Backplane Port Num Outbound Packets Error detected

C02 LSB C02

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40349 1 MS Byte LS Byte Port 3 Port Diagnostics Data Validity
... ... ... ... ...
40450 2 MSB C00 C01 Port 3 Num Outbound Packets Error detected

C02 LSB C03

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40452 1 MS Byte LS Byte Port 4 Port Diagnostics Data Validity
... ... ... ... ...
40553 2 MSB C00 C01 Port 4 Num Outbound Packets Error detected

C02 LSB C03
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Modbus Function Code 3: Modbus TCP Port 502 Diagnostic Data
Modbus TCP port 502 diagnostics start at address 40555 (decimal) as described in the following 
table.

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40555 2 MS Byte 00 Byte 01 Modbus TCP/Port 502 Diagnostic 
Data ValidityByte 02 LS Byte 03

40557 1 MS Byte LS Byte Port 502 Status
40558 1 MS Byte LS Byte Num Open Connections
40559 2 MSB C00 C01 Num MB Messages Sent

C02 LSB C03
40561 2 MSB C00 C01 Num MB Messages Received

C02 LSB C03
40563 1 MS Byte LS Byte Num MB Open Client Connections
40564 1 MS Byte LS Byte Num MB Open Server Connections
40565 1 MS Byte LS Byte Max Num Connections
40566 1 MS Byte LS Byte Max Num Client Connections
40567 1 MS Byte LS Byte Max Num Server Connections
40568 2 MSB C00 C01 Num MB Detected Error Messages 

SentC02 LSB C03
40570 1 MS Byte LS Byte Num Open Priority Connections
40571 1 MS Byte LS Byte Max Num Priority Connections
40572 1 MS Byte LS Byte Num Entries in Unauthorized Table
40573 2 MSB - IP1 IP2 Remote IP Address 1 Connection 1

IP3 LSB - IP4
40575 1 MS Byte LS Byte Num Attempts to Open 

Unauthorized Connection 1
40576 2 MSB - IP1 IP2 Remote IP Address 2 Connection 2

IP3 LSB - IP4
40578 2 MS Byte LS Byte Num Attempts to Open 

Unauthorized Connection 2
... ... ... ... ...
40663 2 MSB - IP1 IP2 Remote IP Address 31 Connection 31

IP3 LSB - IP4
40665 1 MS Byte LS Byte Num Attempts to Open 

Unauthorized Connection 31
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Modbus Function Code 3: Modbus TCP Port 502 Connection Table Data
Modbus TCP port 502 connection table data starts at address 40669 (decimal) as described in the 
following table.

40666 2 MSB - IP1 IP2 Remote IP Address 32 Connection 32
IP3 LSB - IP4

40668 1 MS Byte LS Byte Num Attempts to Open 
Unauthorized Connection 32

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE

40669 1 MS Byte LS Byte Connection Table Validity
40670 1 MS Byte LS Byte Number of Entries
40671 1 MS Byte LS Byte Starting Entry Index
40672 1 MS Byte LS Byte Connection 1 Index Connection 1
40673 2 IP1 IP2 Connection 1 Remote IP Address

IP3 IP4
40675 1 MS Byte LS Byte Connection 1 Remote Port Number
40676 1 MS Byte LS Byte Connection 1 Local Port Number
40677 1 MS Byte LS Byte Num MB Messages Sent on 

Connection 1
40678 1 MS Byte LS Byte Num MB Messages Received on 

Connection 1
40679 1 MS Byte LS Byte Num MB Detected Error Messages 

Sent on Connection 1
40680 1 MS Byte LS Byte Connection 2 Index Connection 2
40681 2 IP1 IP2 Connection 2 Remote IP Address

IP3 IP4
40683 1 MS Byte LS Byte Connection 2 Remote Port Number
40684 1 MS Byte LS Byte Connection 2 Local Port Number
40685 1 MS Byte LS Byte Num MB Messages Sent on 

Connection 2
40686 1 MS Byte LS Byte Num MB Messages Received on 

Connection 2
40687 1 MS Byte LS Byte Num MB Detected Error Messages 

Sent on Connection 2
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... ... ... ... ...
41168 1 MS Byte LS Byte Connection 63 Index Connection 63*
41169 2 IP1 IP2 Connection 63 Remote IP Address

IP3 IP4
41171 1 MS Byte LS Byte Connection 63 Remote Port 

Number
41172 1 MS Byte LS Byte Connection 63 Local Port Number
41173 1 MS Byte LS Byte Num MB Messages Sent on 

Connection 63
41174 1 MS Byte LS Byte Num MB Messages Received on 

Connection 63
41175 1 MS Byte LS Byte Num MB Detected Error Messages 

Sent on Connection 63
41176 1 MS Byte LS Byte Connection 64 Index Connection 64*
41177 2 IP1 IP2 Connection 64 Remote IP Address

IP3 IP4
415179 1 MS Byte LS Byte Connection 64 Remote Port 

Number
41180 1 MS Byte LS Byte Connection 64 Local Port Number
41181 1 MS Byte LS Byte Num MB Messages Sent on 

Connection 64
41182 1 MS Byte LS Byte Num MB Messages Received on 

Connection 64
41183 1 MS Byte LS Byte Num MB Detected Error Messages 

Sent on Connection 64
*140 CRA 312 10 and BMX CRA 312 •0 RIO adapter modules support a maximum of 8 connections.

Starting 
Address

Length Register Byte Order Comments
MS BYTE LS BYTE
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Diagnostics Available through EtherNet/IP CIP Objects

Section 6.5
Diagnostics Available through EtherNet/IP CIP Objects

Introduction
Quantum Ethernet I/O applications use CIP within a producer/consumer model to provide 
communication services in an industrial environment. This section describes the available CIP 
objects for Quantum EIO modules.

What Is in This Section?
This section contains the following topics:

Topic Page
About CIP Objects 135
Identity Object 136
Assembly Object 138
Connection Manager Object 140
Quality Of Service (QoS) Object 142
TCP/IP Interface Object 144
Ethernet Link Object 146
EtherNet/IP Interface Diagnostics Object 150
EtherNet/IP IO Scanner Diagnostics Object 153
IO Connection Diagnostics Object 155
EtherNet/IP Explicit Connection Diagnostics Object 159
EtherNet/IP Explicit Connection Diagnostics List Object 161
RSTP Diagnostics Object 163
Service Port Control Object 168
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About CIP Objects

Overview
The Ethernet communication module can access CIP data and services located in connected 
devices. The CIP objects and their content depend on the design of each device.
CIP object data and content are exposed—and accessed—hierarchically in the following nested 
levels:

NOTE: 
You can use explicit messaging to access these items:
 Access a collection of instance attributes by including only the class and instance values for the 

object in the explicit message.
 Access a single attribute by adding a specific attribute value to the explicit message with the 

class and instance values for the object.
This chapter describes the CIP objects that the Ethernet communication module exposes to 
remote devices.
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Identity Object

Overview
The Identity object presents the instances, attributes and services described below.

Class ID
01

Instance IDs
The Identity object presents two instances:
 0: class
 1: instance

Attributes
Identity object attributes are associated with each instance, as follows:
Instance ID = 0 (class attributes):

Instance ID = 1 (instance attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported

Attribute ID Description Type GET SET
hex dec
01 01 Vendor ID UINT X —
02 02 Device Type UINT X —
03 03 Product Code UINT X —
04 04 Revision STRUCT X —

Major USINT
Minor USINT

X = supported
— = not supported
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Services
The Identity object performs the following services upon the listed object types:

05 05 Status
bit 2: 

0x01=the module is configured
bits 4-7: 

0x03=no I/O connections established
0x06=at least 1 I/O connection in run mode
0x07=at least 1 I/O connection established, all 

in IDLE mode

Word X —

06 06 Serial Number UDINT X —
07 07 Product Name STRING X —
18 24 Modbus Identity STRUCT X —

Attribute ID Description Type GET SET
hex dec

X = supported
— = not supported

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns:

 all class attributes (instance = 0)
 instance attributes 1 to 7 (instance = 1)

0E 14 Get_Attribute_Single X X Returns the value of the specified attribute.
X = supported
— = not supported
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Assembly Object

Overview
The Assembly object consists of the attributes and services described below.
NOTE: You can send an explicit message to the Assembly object only when no other connections 
have been established that read from or write to this object. For example, you can send an explicit 
message to the Assembly object if a local slave instance is enabled, but no other module is 
scanning that local slave.

Class ID
04

Instance IDs
The Assembly object presents the following instance identifiers:
 0: class
 101, 102, 111, 112, 121, 122: instance

Attributes
The Assembly object consists of the following attributes:
Instance ID = 0 (class attributes):

Instance attributes:

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
03 Number of Instances X —
X = supported
— = not supported

Instance ID Attribute ID Description Type GET SET
101 03 Local slave 1: T->O input data Array of BYTE X —
102 Local slave 1: O>T Array of BYTE X X
111 Local slave 2: T->O input data Array of BYTE X —
112 Local slave 2: O>T Array of BYTE X X
121 Local slave 3: T->O input data Array of BYTE X —
122 Local slave 3: O>T Array of BYTE X X
X = supported
— = not supported
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Services
The CIP Assembly object performs these services upon the listed object types:

Service ID Description Class Instance Notes
hex dec
0E 14 Get_Attribute_Single X X Returns the value of the specified attribute
10 16 Set_Attribute_Single1 — X Returns these values:

0E=attribute not settable: assembly is not o->T type
0F=permission denied: assembly is being used by an 
active connection
13=config too small: the Set_Attribute_Single 
command contains partial data
15=data too big: the Set_Attribute_Single command 
contains too much data

X = supported
— = not supported
1. When valid, the size of the data written to the Assembly object using the Set_Attribute_Single service equals the 
size of the Assembly object as configured in the target module.
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Connection Manager Object

Overview
The Connection Manager object presents the instances, attributes and services described below.

Class ID
06

Instance IDs
The Connection Manager object presents two instance values:
 0: class 
 1: instance

Attributes
Connection Manager object attributes are associated with each instance, as follows:
Instance ID = 0 (class attributes):

Instance ID = 1 (instance attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported

Attribute ID Description Type GET SET Value
hex dec
01 01 Open Requests UINT X X Number of Forward Open service 

requests received
02 02 Open Format 

Rejects
UINT X X Number of Forward Open service 

requests that were rejected due to bad 
format

03 03 Open Resource 
Rejects

UINT X X Number of Forward Open service 
requests that were rejected due to lack 
of resources

X = supported
— = not supported
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Services
The Connection Manager object performs the following services on the listed object types:

04 04 Open Other 
Rejects

UINT X X Number of Forward Open service 
requests that were rejected for reasons 
other than bad format or lack of 
resources

05 05 Close Requests UINT X X Number of Forward Close service 
requests received

06 06 Close Format 
Requests

UINT X X Number of Forward Close service 
requests that were rejected due to bad 
format

07 07 Close Other 
Requests

UINT X X Number of Forward Close service 
requests that were rejected for reasons 
other than bad format

08 08 Connection 
Timeouts

UINT X X Total number of connection timeouts 
that occurred in connections controlled 
by this connections manager

09 09 Connection Entry 
List

STRUCT X — 0 (Unsupported optional item

0B 11 CPU_Utilization UINT X — 0 (Unsupported optional item
0C 12 MaxBuffSize UDINT X — 0 (Unsupported optional item
0D 13 BufSize Remaining UDINT X — 0 (Unsupported optional item

Attribute ID Description Type GET SET Value
hex dec

X = supported
— = not supported

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
0E 14 Get_Attribute_Single X X Returns the value of the specified attribute.
X = supported
— = not supported
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Quality Of Service (QoS) Object

Overview
The QoS object implements Differentiated Services Code Point (DSCP or DiffServe) values for the 
purpose of providing a method of prioritizing Ethernet messages. The QoS object presents the 
instances, attributes and services described below.

Class ID
48 (hex), 72 (decimal)

Instance IDs
The QoS object presents two instance values:
 0: class 
 1: instance

Attributes
The QoS object consists of the following attributes:
Instance ID = 0 (class attributes):

Instance ID = 1 (instance attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported

Attribute ID Description Type GET SET Value
04 DSCP Urgent USINT X X For CIP transport class 0/1 Urgent priority 

messages, default value = 55.
05 DSCP Scheduled USINT X X For CIP transport class 0/1 Urgent priority 

messages, default value = 47.
06 DSCP High USINT X X For CIP transport class 0/1 Urgent priority 

messages, default value = 43.
07 DSCP Low USINT X X For CIP transport class 0/1 Urgent priority 

messages, default value = 31.
08 DSCP Explicit USINT X X For CIP explicit messages (transport 

class 2/3 and UCMM), default value = 27.
X = supported
— = not supported
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NOTE: A change in the instance attribute value takes effect on device re-start, for configurations 
made from flash memory.

Services
The QoS object performs the following services upon the listed object types:

Service ID Description Class Instance
hex dec
0E 14 Get_Attribute_Single X X
10 16 Set_Attribute_Single — X
X = supported
— = not supported
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TCP/IP Interface Object

Overview
The TCP/IP interface object presents the instances (per network), attributes and services 
described below.

Class ID
F5 (hex), 245 (decimal)

Instance IDs
The TCP/IP interface object presents 2 instance values:
 0: class 
 1: instance

Attributes
TCP/IP interface object attributes are associated with each instance, as follows:
Instance ID = 0 (class attributes):

Instance ID = 1 (instance attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported

Attribute ID Description Type GET SET Value
01 Status DWORD X — 0x01
02 Configuration 

Capability
DWORD X — 0x01 = from BootP

0x11 = from flash
0x00 = other

03 Configuration Control DWORD X X 0x01 = out-of-box default 
04 Physical Link Object STRUCT X —

Path Size UINT
Path Padded 

EPATH
X = supported
— = not supported
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Services
The TCP/IP interface object performs the following services upon the listed object types:

05 Interface 
Configuration

STRUCT X X 0x00 = out-of-box default 

IP Address UDINT
Network Mask UDINT
Gateway Address UDINT
Name Server UDINT
Name Server 2 UDINT
Domain Name STRING

06 Host Name STRING X —

Attribute ID Description Type GET SET Value

X = supported
— = not supported

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all 

attributes.
0E 14 Get_Attribute_Single X X Returns the value of the 

specified attribute.
10 16 Set_Attribute_Single1 — X Sets the value of the 

specified attribute.
X = supported
— = not supported
1. The Set_Attribute_Single service can execute only when these preconditions are satisfied:
 Configure the Ethernet communication module to obtain its IP address from flash memory.
 Confirm that the PLC is in stop mode.
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Ethernet Link Object

Overview
The Ethernet Link object consists of the instances, attributes and services described below.

Class ID
F6 (hex), 246 (decimal)

Instance IDs
The Ethernet Link object presents the following instance values:
 0: class 
 1: port 1
 2: port 2
 3: port 3
 4: port 4

Attributes
The Ethernet Link object presents the following attributes:
Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
03 Number of Instances X —
X = supported
— = not supported
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Instance ID = 1 (instance attributes):

Attribute ID Description Type GET SET Value
hex dec
01 01 Interface Speed UDINT X — Valid values include: 

0, 10000000, 100000000
02 02 Interface Flags DWORD X — Bit 0: link status

0 = Inactive
1 = Active
Bit 1: duplex mode
0 = half duplex
1 = full duplex
Bits 2—4: negotiation status
3 = successfully negotiated speed and duplex
4 = forced speed and link
Bit 5: manual setting requires reset
0 = automatic
1 = device need reset
Bit 6: local hardware detected error
0 = no event
1 = event detected

03 03 Physical Address ARRAY 
of 6 
USINT

X — module MAC address

04 04 Interface Counters STRUCT X —
In octets UDINT octets received on the interface
In Ucast Packets UDINT unicast packets received on the interface
In NUcast Packets UDINT non-unicast packets received on the interface
In Discards UDINT inbound packets received on the interface, but 

discarded
In Errors UDINT inbound packets with detected errors (does not 

include in discards)
In Unknown Protos UDINT inbound packets with unknown protocol
Out Octets UDINT octets sent on the interface
Out Ucast Packets UDINT unicast packets sent on the interface
Out NUcast Packets UDINT non-unicast packets sent on the interface
Out Discards UDINT outbound packets discarded
Out Errors UDINT outbound packets with detected errors

X = supported
— = not supported
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05 05 Media Counters STRUCT X —
Alignment Errors UDINT frames that are not an integral number of octets 

in length
FCS Errors UDINT bad CRC — frames received do not pass the 

FCS check
Single Collisions UDINT successfully transmitted frames that 

experienced exactly 1 collision
Multiple Collisions UDINT successfully transmitted frames that 

experienced more than 1 collision
SQE Test Errors UDINT number of times the detected SQE test error is 

generated
Deferred Transmissions UDINT frames for which first transmission attempt is 

delayed because the medium is busy
Late Collisions UDINT number of times a collision is detected later 

than 512 bit times into the transmission of a 
packet

Excessive Collisions UDINT frames that do not transmit due to excessive 
collisions

MAC Transmit Errors UDINT frames that do not transmit due to a detected 
internal MAC sublayer transmit error

Carrier Sense Errors UDINT times that the carrier sense condition was lost 
or not asserted when attempting to transmit a 
frame

Frame Too Long UDINT frames received that exceed the maximum 
permitted frame size

MAC Receive Errors UDINT frames not received on an interface due to a 
detected internal MAC sublayer receive error

Attribute ID Description Type GET SET Value
hex dec

X = supported
— = not supported
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Services
The Ethernet Link object performs the following services upon the listed object types:

06 06 Interface Control STRUCT X X API of the connection
Control Bits WORD Bit 0: Auto-negotiation

0 = disabled
1 = enabled
Note: When auto-negotiation is enabled, 0x0C 
(object state conflict) is returned when 
attempting to set either:
 forced interface speed

or
 forced duplex mode 

Bit 1: forced duplex mode (if auto-negotiation 
bit = 0)
0 = half duplex
1 = full duplex

Forced Interface Speed UINT Valid values include: 
10000000, 100000000
Note: Attempting to set any other value returns 
the detected error 0x09 (invalid attribute value)

10 16 Interface Label SHORT_
STRING

X — A fixed textual string identifying the interface, 
that should include ‘internal’ for internal 
interfaces. Maximum number of characters is 
64.

Attribute ID Description Type GET SET Value
hex dec

X = supported
— = not supported

Service ID Description Class Instance
hex dec
01 01 Get_Attributes_All X X
10 16 Set_Attribute_Single — X
0E 14 Get_Attribute_Single X X
4C 76 Get_and_Clear — X
X = supported
— = not supported
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EtherNet/IP Interface Diagnostics Object

Overview
The EtherNet/IP Interface Diagnostics object presents the instances, attributes and services 
described below.

Class ID
350 (hex), 848 (decimal)

Instance IDs
The EtherNet/IP Interface object presents two instance values:
 0: class 
 1: instance

Attributes
EtherNet/IP Interface Diagnostics object attributes are associated with each instance, as follows:
Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported
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Instance ID = 1 (instance attributes):

Attribute ID Description Type GET SET Value
01 Protocols Supported UINT X —
02 Connection Diagnostics STRUCT X —

Max CIP IO Connections 
opened

UINT Number of Class 1 connections opened since the 
last reset

Current CIP IO Connections UINT Number of Class 1 connections currently opened
Max CIP Explicit 
Connections opened

UINT Number of Class 3 connections opened since the 
last reset

Current CIP Explicit 
Connections

UINT Number of Class 3 connections currently opened

CIP Connections Opening 
Errors

UINT Increments each time a Forward Open is not 
successful (Originator and Target)

CIP Connections Timeout 
Errors

UINT Increments when a connection times out 
(Originator and Target)

Max EIP TCP Connections 
opened

UINT Number of TCP connections (used for EIP, as 
client or server) opened since the last reset

Current EIP TCP 
Connections

UINT Number of TCP connections (used for EIP, as 
client or server) currently open

03 IO Messaging Diagnostics STRUCT X X
IO Production Counter UDINT Increments each time a Class 0/1 message is 

sent
IO Consumption Counter UDINT Increments each time a Class 0/1 message is 

received
IO Production Send Errors 
Counter

UINT Increments each time a Class 0/1 message is not 
sent

IO Consumption Receive 
Errors Counter

UINT Increments each time a consumption is received 
with a detected error

04 Explicit Messaging 
Diagnostics

STRUCT X X

Class 3 Msg Send Counter UDINT Increments each time a Class 3 message is sent 
(client and server)

Class 3 Msg Receive 
Counter

UDINT Increments each time a Class 3 message is 
received (client and server)

UCMM Msg Receive Counter UDINT Increments each time a UCMM message is sent 
(client and server)

UCMM Msg Receive Counter UDINT Increments each time a UCMM message is 
received (client and server)

X = supported
— = not supported
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Services
The EtherNet/IP Interface Diagnostics object performs the following services upon the listed object 
types:

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
0E 14 Get_Attribute_Single — X Returns the value of the specified attribute.
4C 76 Get_and_Clear — X Returns and clears the values of all instance 

attributes.
X = supported
— = not supported
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EtherNet/IP IO Scanner Diagnostics Object

Overview
The EtherNet/IP IO Scanner Diagnostics object presents the instances, attributes and services 
described below.

Class ID
351 (hex), 849 (decimal)

Instance IDs
The EtherNet/IP IO Scanner Diagnostics object presents two instances:
 0: class
 1: instance

Attributes
EtherNet/IP IO Scanner Diagnostics object attributes are associated with each instance, as 
follows:
Instance ID = 0 (class attributes):

Instance ID = 1 (instance attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported

Attribute ID Description Type GET SET
01 IO Status Table STRUCT X —

Size UINT
Status ARRAY of 

UNINT
X = supported
— = not supported
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Services
The EtherNet/IP IO Scanner Diagnostics object performs the following services upon the listed 
object types:

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
0E 14 Get_Attribute_Single X X Returns the value of the specified attribute.
X = supported
— = not supported
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IO Connection Diagnostics Object

Overview
The IO Connection Diagnostics object presents the instances, attributes and services described 
below.

Class ID
352 (hex), 850 (decimal)

Instance IDs
The IO Connection Diagnostics object presents two instance values:
 0: class 
 1...256: instance (The instance number is the connection number in the configuration.)

Attributes
IO Connection Diagnostics object attributes are associated with each instance, as follows:
Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported
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Instance ID = 1 to 256 (instance attributes):

Attribute ID Description Type GET SET Value
01 IO Communication Diagnostics STRUCT X X

IO Production Counter UDINT Increments at each production
IO Consumption Counter UDINT Increments at each consumption
IO Production Send Errors Counter UINT Increments each time a production is not 

sent
IO Consumption Receive Errors 
Counter

UINT Increments each time a consumption is 
received with a detected error

CIP Connection Timeout Errors UINT Increments when a connection times out
CIP Connection Opening Errors UINT Increments each time a connection is 

unable to open
CIP Connection State UINT State of the Connection Bit 
CIP Last Error General Status UINT General status of the last error detected 

on the connection
CIP Last Error Extended Status UINT Extended status of the last error detected 

on the connection
Input Communication Status UINT Communication status of the inputs (see 

table, below)
Output Communication Status UINT Communication status of the outputs 

(see table, below)
X = supported
— = not supported
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The following values describe the structure of the instance attributes: CIP Connection State, 
Input Communication Status, and Output Communication Status: 

02 Connection Diagnostics STRUCT X X
Production Connection ID UDINT Connection ID for production
Consumption Connection ID UDINT Connection ID for consumption
Production RPI UDINT RPI for production
Production API UDINT API for production
Consumption RPI UDINT RPI for consumption
Consumption API UDINT API for consumption
Production Connection Parameters UDINT Connection parameters for production
Consumption Connection 
Parameters

UDINT Connection parameters for consumption

Local IP UDINT —
Local UDP Port UINT —
Remote IP UDINT —
Remote UDP Port UINT —
Production Multicast IP UDINT Multicast IP used for production (or 0)
Consumption Multicast IP UDINT Multicast IP used for consumption (or 0)
Protocols Supported UDINT Protocol supported on the connection:

1 = EtherNet/IP

Attribute ID Description Type GET SET Value

X = supported
— = not supported

Bit Number Description Values
15...3 Reserved 0
2 Idle 0 = no idle notification

1 = idle notification
1 Consumption inhibited 0 = consumption started

1 = no consumption
0 Production inhibited 0 = production started

1 = no production
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Services
The EtherNet/IP Interface Diagnostics object performs the following services upon the listed object 
types:

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
0E 14 Get_Attribute_Single — X Returns the value of the specified attribute.
4C 76 Get_and_Clear — X Returns and clears the values of all instance 

attributes.
X = supported
— = not supported
158 S1A48978 12/2018



Diagnostics
EtherNet/IP Explicit Connection Diagnostics Object

Overview
The EtherNet/IP Explicit Connection Diagnostics object presents the instances, attributes and 
services described below.

Class ID
353 (hex), 851 (decimal)

Instance IDs
The EtherNet/IP Explicit Connection Diagnostics object presents two instance values:
 0: class 
 1...N: instance (N = maximum concurrent number of explicit connections)

Attributes
EtherNet/IP Explicit Connection Diagnostics object attributes are associated with each instance, 
as follows:
Instance ID = 0 (class attributes):

Attribute ID hex Description Value GET SET
01 Revision 1 X —
02 Max Instance 0...N X —
X = supported
— = not supported
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Instance ID = 1 to N (instance attributes):

Services
The EtherNet/IP Explicit Connection Diagnostics object performs the following services upon the 
listed object type:

Attribute ID 
hex

Description Type GET SET Value

01 Originator connection ID UDINT X — Originator to target connection ID
02 Originator IP UINT X —
03 Originator TCP Port UDINT X —
04 Target connection ID UDINT X — Target to originator connection ID
05 Target IP UDINT X —
06 Target TCP Port UDINT X —
07 Msg Send Counter UDINT X — Incremented each time a Class 3 

CIP message is sent on the 
connection

08 Msg Receive counter UDINT X — Increments each time a Class 3 CIP 
message is received on the 
connection

X = supported
— = not supported

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
X = supported
— = not supported
160 S1A48978 12/2018



Diagnostics
EtherNet/IP Explicit Connection Diagnostics List Object

Overview
The EtherNet/IP Explicit Connection Diagnostics List object presents the instances, attributes and 
services described below.

Class ID
354 (hex), 852 (decimal)

Instance IDs
The EtherNet/IP Explicit Connection Diagnostics List object presents two instance values:
 0: class 
 1...N: instance

Attributes
EtherNet/IP Explicit Connection Diagnostics List object attributes are associated with each 
instance, as follows:
Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported
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Instance ID = 1 to N (instance attributes):

Services
The EtherNet/IP Explicit Connection Diagnostics object performs the following services upon the 
listed object types:

Attribute ID Description Type GET SET Value
01 Number of connections UINT X — Total number of opened explicit connections
02 Explicit Messaging 

Connections Diagnostic 
List

ARRAY of 
STRUCT

X —

Originator connection ID UDINT O->T connection ID
Originator IP UINT —
Originator TCP port UDINT —
Target connection ID UDINT T->O connection ID
Target IP UDINT —
Target TCP port UDINT —
Msg Send counter UDINT Increments each time a Class 3 CIP 

message is sent on the connection
Msg Receive counter UDINT Increments each time a Class 3 CIP 

message is received on the connection
X = supported
— = not supported

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X — Returns the value of all attributes.
08 08 Create X — —
09 09 Delete — X —
4B 75 Explicit_Connections_

Diagnostic_Read
— X —

X = supported
— = not supported
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RSTP Diagnostics Object

Overview
The RSTP Diagnostics object presents the instances, attributes and services described below.

Class ID
355 (hex), 853 (decimal)

Instance IDs
The RSTP Diagnostics object presents these instance values:
 0: class 
 1: instance

Attributes
RSTP Diagnostics object attributes are associated with each instance.
Instance ID = 0 (class attributes):

Attribute ID Description Type GET SET
01 Revision: This attribute specifies the current revision of the RSTP 

Diagnostic Object. The revision is increased by 1 at each new update 
of the object.

UINT X —

02 Max Instance: This attribute specifies the maximum number of 
instances that may be created for this object on a per device basis 
(for example, an RSTP Bridge). There is 1 instance for each RSTP 
port on a device.

UINT X —

X = supported
— = not supported
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Instance ID = 1 to N (instance attributes):

Attribute ID Description Type GET CLEAR Value
01 Switch Status STRUCT X — —

Protocol Specification UINT X — Refer to RFC-4188 for attribute definitions 
and value range. In addition, the following 
value is defined: [4]: the protocol is IEEE 
802.1D-2004 and IEEE 802.1W

Bridge Priority UDINT X — Refer to RFC-4188 for attribute definitions 
and value range.Time Since Topology Change UDINT X —

Topology Change Count UDINT X — Refer to RFC-4188 for attribute definitions 
and value range.

Designated Root String X — Refer to RFC-4188 for attribute definitions 
and value range.Root Cost UDINT X —

Root Port UDINT X —
Max Age UINT X —
Hello Time UINT X —
Hold Time UDINT X —
Forward Delay UINT X —
Bridge Max Age UINT X —
Bridge Hello Time UINT X —
Bridge Forward Delay UINT X —

X = supported
— = not supported
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02 Port Status STRUCT X X —
Port UDINT X X Refer to RFC-4188 for attribute definitions 

and value range.Priority UDINT X X
State UINT X X
Enable UINT X X
Path Cost UDINT X X
Designated Root String X X
Designated Cost UDINT X X
Designated Bridge String X X
Designated Port String X X
Forward Transitions Count UDINT X X Refer to RFC-4188 for attribute definitions 

and value range. 
Services:
 Get_and_Clear: The current value of this 

parameter is returned with the response 
message.

 other services: The current value of this 
parameter is returned without being 
cleared.

Attribute ID Description Type GET CLEAR Value

X = supported
— = not supported
S1A48978 12/2018 165



Diagnostics
03 Port Mode STRUCT X — —
Port Number UINT X — This attribute indicates the port number for a 

data query. The value range is configuration 
dependent. For a 4-port Ethernet device, as 
an instance, the valid range is 1...4.

Admin Edge Port UINT X — This attribute indicates if this is a user-
configured edge port:
 1: true
 2: false

Other values are not valid.
Oper Edge Port UINT X — This attribute indicates if this port is currently 

an edge port:
 1: true
 2: false

Other values are not valid.
Auto Edge Port UINT X — This attribute indicates if this port is a 

dynamically determined edge port:
 1: true
 2: false

Other values are not valid.

Attribute ID Description Type GET CLEAR Value

X = supported
— = not supported
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Services
The RSTP Diagnostics object performs these services:

Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X This service returns:

 all attributes of the class
 all attributes of the instance of the object

02 02 Get_Attribute_Single X X This service returns:
 the contents of a single attribute of the class
 the contents of the instance of the object as 

specified
Specify the attribute ID in the request for this 
service.

32 50 Get_and_Clear — X This service returns the contents of a single 
attribute of the instance of the object as 
specified. Then the relevant counter-like 
parameter(s) within the specified attribute are 
cleared. (Specify the attribute ID in the request 
for this service.)

X = supported
— = not supported
S1A48978 12/2018 167



Diagnostics
Service Port Control Object

Overview
The Service Port Control object is defined for port control purposes.

Class ID
400 (hex), 1024 (decimal)

Instance IDs
The Service Port Control object presents these instance Values:
 0: class
 1: instance

Attributes
Service Port Control object attributes are associated with each instance.
Required class attributes (instance 0):

Required instance attributes (instance 1):

Attribute ID Description Type Get Set
01 Revision UINT X —
02 Max Instance UINT X —
X = supported
— = not supported

Attribute ID Description Type Get Set Value
hex dec
01 01 Port Control UINT X X 0 (default): disabled

1: access port
2: port mirroring
3: extended port

02 02 Mirror UINT X X bit 0 (default): ETH2 port
bit 1: ETH3 port
bit 2: ETH4 port
bit 3: internal port

X = supported
— = not supported
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NOTE:  
 If the SERVICE/EXTEND port is not configured for port mirroring, the mirror attribute is ignored. 

If the value of a parameter request is outside the valid range, the service request is ignored.
 In port mirroring mode, the SERVICE/EXTEND port acts like a read-only port. That is, you 

cannot access devices (ping, connection to Control Expert, etc.) through the 
SERVICE/EXTEND port.

Services
The Service Port Control object performs these services for these object types:

Service ID Name Class Instance Description
hex dec
01 01 Get_Attributes_All X X Get all attributes in a single message.
02 02 Set_Attributes_All — X Set all attributes in a single message.
0E 14 Get_Attribute_Single X X Get a single specified attribute.
10 16 Set_Attribute_Single — X Set a single specified attribute.
X = supported
— = not supported
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Diagnostics Available through Control Expert

Section 6.6
Diagnostics Available through Control Expert

Introduction
The Quantum EIO modules support online actions. Use the online actions to perform these tasks:
 Display EtherNet/IP objects for the head module or a remote EtherNet/IP device.
 View and edit the service/extend port configuration parameters for the head module/
 Ping the head module or a remote EtherNet/IP or Modbus TCP device to confirm it is active on 

the Ethernet network.
 Connect to a remote device to perform these actions:
 View the remote device’s default parameter settings.
 View the remote device’s current parameter settings.
 Edit and download to the remote device its editable parameter settings.

What Is in This Section?
This section contains the following topics:

Topic Page
Device Services 171
EtherNet/IP Objects 172
Service Port Management (Online Action) 173
Pinging the 140CRP31200 Module 175
Displaying I/O Memory Consumption 177
Logging DTM Events to a Control Expert Logging Screen 178
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Device Services

Access the Device Services Tab
The Control Expert IP configuration parameters apply to the 140 CRP 312 00 head module in the 
local rack. To access the Device Services tab, double-click on the 140 CRP 312 00 module 
(see page 51).

Device Services Parameters
These parameters are found on the Control Expert Device Services tab:

Access Online Action
In the CRP Diagnostics field, select Connect to connect to the PLC and press Apply to access the 
configuration tabs for Online Action or EtherNet/IP Explicit Message:
 Online Action configuration tabs:
 EtherNet/IP Objects (see page 172)
 Service Port (see page 173)
 Ping (see page 175)

 EtherNet/IP Explicit Message (see page 100)

Field Parameter Description
Network Card Card IP address of the PC
CRP Diagnostics
(See below.)

 Connect
 Disconnect

connection to the 
140 CRP 312 00

 Online Action
 EtherNet/IP Explicit Message

Apply apply configuration
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EtherNet/IP Objects

View Parameters
Use the EtherNet/IP Objects tab to view available EtherNet/IP parameters:

Step Action Comment
1 In Control Expert, access the module for 

Online Action.
Refer to Online Action (see page 171).

2 Double-click on the 140 CRP 312 00 
module in the Control Expert rack view.

3 Select the EtherNet/IP Objects tab. View these parameters:
 Group/Parameters
 Value
 Unit

4 Press Refresh. This action updates the screen with current 
parameters.
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Service Port Management (Online Action)

Introduction
Configure the SERVICE port for the 140CRP31200 module on the Control Expert Service Port tab.

Access the Service Port Tab

Service Port Parameters

Buttons on the Service Port tab:

Step Action
1 In Control Expert, access the module for Online Action. Refer to Online Action (see page 171).
2 Double-click the 140CRP31200 module in the Control Expert rack view.
3 Select the Service Port tab.

Field Parameter Value Comment
Service Port Mode Access (default) ETH1 You cannot edit the value in the Service Port 

Number field.Mirroring ETH1
Access Port 
Configuration

Service Port 
Number

ETH1 Service Port Mode = Mirroring (see note)
ETH1 Service Port Mode = any available source port

Port Mirroring 
Configuration

Source Port(s) Internal Port Yes Ethernet traffic destined for the module
No

ETH2 Yes traffic through the 140CRP31200 INTERLINK port
No

ETH3 Yes Ethernet traffic through the first remote I/O port
No

ETH4 Yes Ethernet traffic through the second remote I/O port
No

Description — — — description of the source port

NOTE: In port mirroring mode, the SERVICE port acts like a read-only port. That is, you cannot access devices (ping, 
connection to Control Expert, etc.) through the SERVICE port.

Button Description
Update After you change Service Port parameters, press this button so that the module 

can use the new configuration.
Refresh This button reads the latest Service Port configuration from the module.
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On Line Behavior
The Service Port parameters are stored in the application, but you can reconfigure (change) the 
parameters in connected mode. Values that you reconfigure in connected mode are sent to the 
140CRP31200 module through explicit messages. (The changed values are not stored, so a 
mismatch can exist between the parameters that are being used and those in the stored 
application.) If the module does not respond to the explicit messages, a message appears.

Limitations
The SERVICE port on the 140CRP31200 module has the same limitations as the cloud port of the 
dual-ring switch (DRS). Therefore, the cloud port on the module and the cloud port on the DRS can 
be connected to the same equipment.
For more information about considerations that apply to the use of the distributed I/O cloud port on 
the DRS, refer to the topic Predefined Configuration Files topic in the Quantum Ethernet I/O 
System Planning Guide.
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Pinging the 140CRP31200 Module

Introduction
Use the Control Expert ping function to send an ICMP echo request to the 140CRP31200 head 
module. The request determines if the target device is present. If the target device is present, the 
request determines the time elapsed until an echo response from the target device is received.

Access the Ping Tab
Open the Control Expert Ping tab:

Ping Tab
This illustration shows the Ping tab and its parameters:

Step Action
1 In Control Expert, access the 140CRP31200 head module for Online Action 

(see page 171).
2 Double-click on the 140CRP31200 head module in the Control Expert rack view.
3 Select the Ping tab.
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Ping parameters:

Field Parameter Value Comment
Address IP Address — IP address of the target module.
Ping Repeat (100ms) checked Ping once.

unchecked Ping every 100 ms.
Stop on Error checked Stop pinging when a detected communication error is 

displayed.
unchecked Continue pinging when a detected communication error is 

displayed.
Ping (button) — Start pinging. (Click again to stop repeated pinging when no 

detected error is displayed.)
Ping Result — This box reports the response to the ping.
Clear (button) — Click this button to clear (empty) Ping Result.
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Displaying I/O Memory Consumption

Displaying Memory Consumption
In Control Expert you can monitor the I/O memory consumption by viewing the bus properties. Use 
one of these methods:
 In the Project Browser, right-click Project → Configuration → EIO Bus → Properties
 In the Project Browser, right-click Project → Configuration → EIO [Quantum or Modicon X80] 

Drop → Properties
 In background of the EIO Bus window, right-click Bus properties.
 In the Edit menu, scroll to Bus properties.
The IO-Memory screen looks like this:

Exceeding EIO Limitations
Control Expert displays a detected error in the log window if one of these events occurs:
 The size of the EIO memory exceeds 1400 input bytes or 1400 output bytes.
 The size of the EIO network exceeds 32768 input bytes or 24576 output bytes.
 The size of the EIO network exceeds 80% of the 32768 input bytes or 80% of the 24576 output 

bytes.
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Logging DTM Events to a Control Expert Logging Screen

Description
Control Expert maintains a log of events for:
 the Control Expert embedded FDT container
 each Ethernet communication module DTM
 each EtherNet/IP remote device DTM
Events relating to the Control Expert FDT container are displayed in the FDT log event page of the 
Output Window.
Events relating to a communication module or remote EtherNet/IP device are displayed:
 in configuration mode: in the Device Editor, by selecting the Logging node in the left pane
 in diagnostic mode: in the Diagnostics window, by selecting the Logging node in the left pane

Logging Attributes
The Logging window displays the result of an operation or function performed by Control Expert. 
Each log entry includes the following attributes:

Accessing the Logging Screen
In Control Expert:

Attribute Description
Date/Time The time the event occurred, displayed in the format: yyyy-mm--dd hh:mm:ss
Log Level The level of event importance. Values include: 

Information A successfully completed operation. 
Warning An operation that Control Expert completed, but which may lead to a 

subsequent error.
Error An operation that Control Expert was unable to complete.

Message A brief description of the core meaning of the event.
Detail Message A more detailed description of the event, which may include parameter names, location 

paths, etc.

Step Action
1 Open a project that includes a BME NOC 03•1 Ethernet communication module.
2 Clock Tools → DTM Browser to open the DTM Browser.
3 In the DTM Browser, double-click the BME NOC 03•1 (or right-click Open) to open the 

configuration window.
4 Select Logging in the navigation tree in the left pane of the window.
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Chapter 7
Firmware Upgrade

Introduction
This chapter describes the steps for upgrading the firmware for your 140CRP31200 head module 
and the 140CRA31200 or BMXCRA312•0 adapter module.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
140CRP31200 Firmware Upgrade 180
Adapter Firmware Upgrade 182
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Firmware Upgrade
140CRP31200 Firmware Upgrade

OS 
Use the Control Expert OS Loader to upgrade the firmware on the 140CRP31200 module. 
OS Loader was installed on your PC when you installed Control Expert. (The minimum required 
version of OS Loader is V6.0. The compatible version is included with your copy of Control Expert.)
A complete firmware upgrade includes the installation of these discrete files:
 kernel
 exec
The kernel and exec files are installed independently. Therefore, perform the firmware upgrade 
process two times (once for each file).
The name of the firmware file indicates the upgrade type (kernel or exec). Examples:
 kernel file name: CCS1_Noc_Kerl_OSLoader.bin
 exec file name: CCS1_Noc_Exec_OSLoader.bin

NOTE: These instructions assume that you are familiar with Control Expert. For more information 
about the OS Loader, refer to the chapter OSLoader Screens (see EcoStruxure™ Control Expert, 
OS Loader, User Manual).

Upgrade Procedure
Follow these steps to upgrade either the firmware kernel or the firmware exec.
NOTE: 
 We recommend that you update the kernel before you upgrade the exec. Both firmware upgrade 

files are installed in the same manner. The only difference is the name of the file you select.
 Confirm that there is no interruption to power or communications during the firmware upgrade 

process. Otherwise, the 140CRP31200 module can be damaged.
 During the firmware upgrade, the I/O communications with the adapter on the remote drop are 

interrupted. After the Hold up time (see page 71) expires, the I/O modules return to their fallback 
state.

Step Action Comment
1 Connect the PC that is running the Control Expert 

OS Loader directly to one of the module ports.
Available ports:
 SERVICE port:
 140CRP31200 head module
 140CRA31200 adapter (Quantum remote 

drop)
 BMXCRA31210 adapter (Modicon X80 

remote drop)
 INTERLINK port (140CRP31200)
 DRS port that is configured for a distributed I/O 

cloud
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Firmware Upgrade
The upgrade process takes approximately 2 minutes:
 1 minute for firmware upgrade
 1 minute to reboot and reestablish I/O connections

Hot Standby
Use these steps to upgrade the 140CRP31200 firmware in Hot Standby configurations:

2 Launch OS Loader. Start → Programs → EcoStruxure Control Expert → 
OS Loader.

3 Click Next to continue. Go directly to the first installation step.
4 Select the FTP communication driver and press 

Next to continue.
The next screen displays a list of devices discovered 
by OS Loader. It also displays the FTP address for 
each discovered device.

5 In the Target Address area, type in the FTP 
Address of the 140CRP31200 module that is the 
target of the upgrade.

—

6 Click Next to continue. Perform these tasks at the 
next installation screen:
a Select Download OS to device.
b Click the Browse button to navigate to and 

select the desired firmware upgrade file.

—

7 Click Next. Perform these tasks at the next 
installation screen:
a Compare the selected firmware File against the 

firmware already loaded in the Device.
b Confirm that the Hardware ID for both the file 

and the device are the same

—

8 Click Next. On the summary page, click Download. The OS Loader displays the progress of the FTP 
session. The download is complete when it displays 
the word SUCCESS.

9 Click Close. The firmware download is finished.

Step Action Comment

Step Action
1 Use the preceding instructions to upgrade the firmware for the 140CRP31200 in the standby 

rack.

NOTE: During the firmware upgrade, the I/O communications with the remote drop’s adapter 
and the 140CRP31200 module in the primary rack are not interrupted. However, the standby I/O 
communications with the adapter are interrupted.

2 When the firmware on the 140CRP31200 in the standby rack is upgraded, perform a manual 
switch-over that gives the newly upgraded standby rack the role of primary rack.

3 Upgrade the firmware for the adapter in the (new) standby rack to facilitate future Hot Standby 
switch-overs.
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Firmware Upgrade
Adapter Firmware Upgrade

Overview
Use these procedures to upgrade the firmware for the 140CRA31200 or BMXCRA312•0 remote 
I/O adapter:

The minimum required version of Unity Loader is V2.2. (V2.3 is required for the BMXCRA312•0 
adapter module and I/O modules in a Modicon X80 Ethernet remote I/O drop.)

Downloading and Installing Unity Loader
Download the Unity Loader software to your PC:

Stage Description
1 Download and install Unity Loader software.
2 Configure and store IP parameters (optional).
3 Connect your configuration PC to the remote I/O adapter.
4 Transfer the firmware upgrade to the remote I/O adapter.

Step Action
1 Enter the web address for Schneider Electric (www.schneider-electric.com) in an Internet 

browser.
2 In the Search from input field, enter the phrase Unity Loader and press Enter.

3 Examine the search results and select the appropriate entry for the Unity Loader software.

NOTE: You can select the Download → Softwares menu command to filter the results.

4 Follow the on-screen instructions to download both the Unity Loader installation software and 
any necessary installation instructions.

5 Run the Unity Loader setup file and follow the instructions (on the screen and in the downloaded 
documentation) to install Unity Loader.
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Default Address Configurations
If you wish, you can configure and store IP parameters for the remote drop’s communications 
adapter when these conditions are met:
 The rotary switch setting is Stored.
 You have not configured and stored valid IP parameters
The adapter uses these default address configurations:

The default address is based on the adapter’s MAC address. This makes it possible for several 
Schneider Electric devices to use their default network configurations on the same network.
To use a specific set of IP parameters, store them in the adapter module. Set the rotary switches 
to the Stored position.
You can send an EtherNet/IP explicit message (see page 93) to the TCP/IP interface object 
(see page 144) of the module to store the configured IP parameters.
NOTE: The adapter uses the stored IP parameters only after a power cycle.

Parameter Description
Default IP Address The default IP address starts with 10.10 and uses the last 2 bytes of the MAC 

address. As an example, a device with the MAC address of 00:00:54:10:8A:05 has a 
default IP address of 10.10.138.5 (0x8A=138, 0x05=5).

Default Sub-
Network Mask

The default mask is 255.0.0.0 (a class A mask).

Default Gateway 
Address

The default gateway address is identical to the default IP address.
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Connect the Configuration PC to the Remote I/O Adapter
Connect your configuration PC (that is running Unity Loader) directly to the 140CRA31200 or 
BMXCRA31210 adapter module. These ports are available:
 SERVICE port
 DRS port that is configured for a distributed I/O cloud
NOTE: There is no SERVICE port on the BMXCRA31200 adapter.
Verify that communications are established between the PC and the adapter by issuing a Ping 
command from the PC:

The command window verifies that a connection is established:

Step Action Comment
1 Open a command window on the PC. Start → Run.
2 In the Run dialog, type in cmd.
3 Click OK.
4 At the command prompt, type in the ping command 

and the device IP address.
Example: C:\>ping 
192.168.21.38:
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Upgrade Procedure
Do not interrupt the firmware download process:
 Do not allow an interruption to the power or the communications during the firmware upgrade 

process.
 Do not shut down the Unity Loader software during the upgrade.
If the firmware download process is interrupted, the new firmware is not installed and the adapter 
continues to use the old firmware. If an interruption occurs, restart the process.
Open Unity Loader on your PC and update the firmware for the remote I/O adapter:

Step Action
1 Open Unity Loader on your PC. (Start → Programs → Schneider Electric → Unity Loader)

Unity Loader opens and displays the Project tabM
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2 In the Connection area of the Project page, connect to the module:
 In the Media list, select Ethernet.
 In the Address field, type in the IP address of the adapter, which is either:
 configured: The adapter is already communicating on the network and the IP address for the 

module is configured in the application (see page 59).
 default: The adapter’s rotary switch position is Stored and you did not already store valid IP 

parameters.
 Click Connect.

3 After Unity Loader has connected to the module, click the Firmware tab:
4 In the PC area, click the ellipsis (...) button to open a dialog where you can navigate to and select the 

firmware file for the network connectivity module. The firmware is contained in a Unity Loader file (.ldx 
extension). 
After you select the firmware file and close the dialog, the selected revision of this firmware is displayed 
in the list on the left, and the current version of the firmware is displayed in the list on the right.

5 When the arrow in the middle of the screen (above) is green, click Transfer.

NOTE: Only click Transfer if the arrow is green. A yellow arrow indicates that the firmware file on your 
computer is the same version or newer than the file selected for transfer; a red arrow indicates that the 
firmware on the computer is not compatible with the remote I/O adapter.

Step Action
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The upgrade process takes approximately 2 minutes:
 firmware upgrade (1 minute)
 reboot, reestablish I/O connections (1 minute)
During the firmware upgrade, the I/O communications with the adapter module may be interrupted. 
After the Hold up time (see page 71) expires, the I/O modules return to their fallback state.

6 Click yes on the 2 dialogs that appear. A third dialog appears (below), which indicates the transfer status 
with the blue bars at the bottom of the screen. After the transfer is complete, click Close.

NOTE: If you are upgrading firmware for more than one remote I/O adapter, additional dialogs will 
appear. Click yes to close each dialog. 

7 In the Unity Loader software, click Disconnect and close the window. 
8 Reboot the module to finalize the firmware update.

Step Action
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A
adapter

The target of real-time I/O data connection requests from scanners. It cannot send or receive real-
time I/O data unless it is configured to do so by a scanner, and it does not store or originate the 
data communications parameters necessary to establish the connection. An adapter accepts 
explicit message requests (connected and unconnected) from other devices.

ART
(application response time) The time a PLC application takes to react to a given input. ART is 
measured from the time a physical signal in the PLC turns on and triggers a write command until 
the remote output turns on to signify that the data has been received.

B
broadcast

A message sent to devices in the subnet.

C
CCOTF

(change configuration on the fly) A feature of Control Expert that allows a PLC hardware change 
in the system configuration while the PLC is operating and not impacting other active drop 
operations.

CIP™
(common industrial protocol) A comprehensive suite of messages and services for the collection 
of manufacturing automation applications (control, safety, synchronization, motion, configuration 
and information). CIP allows users to integrate these manufacturing applications with enterprise-
level Ethernet networks and the internet. CIP is the core protocol of EtherNet/IP.

control network
An Ethernet-based network containing PLCs, SCADA systems, an NTP server, PCs, AMS, 
switches, etc. Two kinds of topologies are supported:
 flat — Devices in this network belong to the same subnet.
 2 levels — The network is split into an operation network and an inter-controller network. These 

2 networks can be physically independent, but are generally linked by a routing device.
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D
DDT

(derived data type) A set of elements with the same type (array) or with different types (structure).

determinism
For a defined application and architecture, the ability to predict that the delay between an event 
(change of an input value) and the corresponding change of an output state is a finite time t, smaller 
than the time required for your process to run correctly.

device network
An Ethernet-based network within a remote I/O network that contains both remote I/O and 
distributed I/O devices. Devices connected on this network follow specific rules to allow remote I/O 
determinism.

distributed I/O device
Any Ethernet device (Schneider Electric device, PC, servers, or third-party devices) that supports 
I/O exchange with a PLC or other Ethernet communication service.

distributed I/O network
A network containing distributed I/O devices that integrates a unique standalone PLC or a unique 
Hot Standby system. I/O scanning may be performed by a communication module interlinked with 
a remote I/O head module on the local rack of an Ethernet remote I/O system. Distributed I/O 
network traffic is delivered after remote I/O traffic, which takes priority in an Ethernet remote I/O 
network.

DRS
(dual-ring switch) A ConneXium extended managed switch with one of several possible predefined 
configurations downloaded to it so that it can participate in an Ethernet I/O network. A DRS 
provides 2 RSTP-enabled ring connections, one for the main ring and one for a sub-ring. It also 
manages QoS, which provides a predictable level of performance for both remote I/O and 
distributed I/O traffic on the same I/O network.
DRSs require a firmware version 6.0 or later.

DTM
(device type manager) A device driver running on the host PC. It provides a unified structure for 
accessing device parameters, configuring and operating the devices, and troubleshooting the 
network. DTMs can range from a simple graphical user interface (GUI) for setting device 
parameters to a highly sophisticated application capable of performing complex real-time 
calculations for diagnosis and maintenance purposes. In the context of a DTM, a device can be a 
communications module or a remote device on the network.
See FDT.
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E
Ethernet

A 10 Mb/s, 100 Mb/s, or 1 Gb/s, CSMA/CD, frame-based LAN that can run over copper twisted pair 
or fiber optic cable, or wireless. The IEEE standard 802.3 defines the rules for configuring a wired 
Ethernet network; the IEEE standard 802.11 defines the rules for configuring a wireless Ethernet 
network. Common forms include 10BASE-T, 100BASE-TX, and 1000BASE-T, which can utilize 
category 5e copper twisted pair cables and RJ45 modular connectors.

EtherNet/IP™
A network communication protocol for industrial automation applications that combines the 
standard internet transmission protocols of TCP/IP and UDP with the application layer common 
industrial protocol (CIP) to support both high speed data exchange and industrial control. 
EtherNet/IP employs electronic data sheets (EDS) to classify each network device and its 
functionality.

explicit messaging
TCP/IP-based messaging for Modbus TCP and EtherNet/IP. It is used for point-to-point, 
client/server messages that include both data (typically unscheduled information between a client 
and a server) and routing information. In EtherNet/IP, explicit messaging is considered class 3 type 
messaging, and can be connection-based or connectionless.

F
FBD

(function block diagram) A graphical programming language that works like a flowchart. By adding 
simple logical blocks (AND, OR, etc.), each function or function block in the program is represented 
in this graphical format. For each block, the inputs are on the left and the outputs on the right. Block 
outputs can be linked to inputs of other blocks in order to create complex expressions.

FDT
(field device tool) The technology that harmonizes communication between field devices and the 
system host.

G
gateway

A device that interconnects 2 different networks, sometimes with different network protocols. When 
used to connect networks based on different protocols, a gateway converts a datagram from one 
protocol stack into the other. When used to connect 2 IP-based networks, a gateway (also called 
a router) has 2 separate IP addresses, one on each network.
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H
Hot Standby

A high-availability control system with a second (standby) PLC that maintains up-to-date system 
status. If the primary PLC becomes inoperable, the standby PLC takes control of the system.

I
I/O scanning

Continuously polling the I/O modules to collect data and status, event, and diagnostics information. 
This process monitors inputs and controls outputs.

implicit messaging
UDP/IP-based class 1 connected messaging for EtherNet/IP. Implicit messaging maintains an 
open connection for the scheduled transfer of control data between a producer and consumer. 
Because an open connection is maintained, each message contains primarily data, without the 
overhead of object information, and a connection identifier.

interlink port
An Ethernet port on Ethernet remote I/O head modules allowing direct connection of distributed I/O 
modules to the remote I/O network and transparency between a control network and the Ethernet 
remote I/O network.

IP address
The 32-bit identifier, consisting of both a network address and a host address, assigned to a device 
connected to a TCP/IP network.

L
local rack

A Quantum rack containing the controller, a power supply, and an Ethernet remote I/O head 
module. A local rack consists of 1 or 2 racks, the main rack (containing the remote I/O head 
module) and an optional extended rack. A Quantum Ethernet remote I/O network requires 1 local 
rack on the main ring.

M
MAST

A master processor task that is run through its programming software. The MAST task has 2 
sections:
 IN: Inputs are copied to the IN section before execution of the MAST task.
 OUT: Outputs are copied to the OUT section after execution of the MAST task.
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multicast
A special form of broadcast where copies of the packet are delivered to only a specified subset of 
network destinations. Implicit messaging typically uses multicast format for communications in an 
EtherNet/IP network.

P
PLC

programmable logic controller. The PLC is the brain of an industrial manufacturing process. It 
automates a process as opposed to relay control systems. PLCs are computers suited to survive 
the harsh conditions of the industrial environment.

port mirroring
In this mode, data traffic that is related to the source port on a network switch is copied to another 
destination port. This allows a connected management tool to monitor and analyze the traffic.
NOTE: In port mirroring mode, the SERVICE port acts like a read-only port. That is, you cannot 
access devices (ping, connection to Control Expert, etc.) through the SERVICE port on the module.

R
remote I/O drop

One of the 3 types of remote I/O devices in an Ethernet remote I/O network. A remote I/O drop is 
a Quantum or an X80 rack of I/O modules that are connected to an Ethernet remote I/O network 
and managed by an Ethernet remote adapter module. A drop can be a single rack or a rack with 
an extension rack.

remote I/O main ring
The main ring of an Ethernet remote I/O network. The ring contains remote I/O devices and a local 
rack (containing a controller, a power supply module, and an Ethernet remote I/O head module).

remote I/O network
An Ethernet-based network that contains 1 standalone PLC or one Hot Standby system and 
remote I/O devices. There are 3 types of remote I/O devices: a local rack, a remote I/O drop, and 
a ConneXium extended dual-ring switch (DRS). Distributed I/O devices may also participate in a 
remote I/O network via connection to DRSs.

RPI
(requested packet interval) The time period between cyclic data transmissions requested by the 
scanner. EtherNet/IP devices publish data at the rate specified by the RPI assigned to them by the 
scanner, and they receive message requests from the scanner at each RPI.

RSTP
(rapid spanning tree protocol) A protocol that allows a network design to include spare (redundant) 
links to provide automatic backup paths if an active link stops working, without the need for loops 
or manual enabling/disabling of backup links.
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S
S908 legacy remote I/O

A Quantum remote I/O system using coaxial cabling and terminators.

service port
A dedicated Ethernet port on the Quantum Ethernet remote I/O modules. The port may support 3 
major functions (depending on the module type):
 port mirroring — for diagnostic use
 access — for connecting HMI/Control Expert/ConneXium Network Manager to the PLC
 extended — to extend the device network to another subnet
 disabled — disables the port, no traffic is forwarded in this mode

SNMP
(simple network management protocol) Protocol used in network management systems to monitor 
network-attached devices for events. The protocol is part of the internet protocol suite (IP) as 
defined by the internet engineering task force (IETF), which consists of network management 
guidelines, including an application layer protocol, a database schema, and a set of data objects.

T
TCP/IP

Also known as internet protocol suite, TCP/IP is a collection of protocols used to conduct 
transactions on a network. The suite takes its name from 2 commonly used protocols: transmission 
control protocol and internet protocol. TCP/IP is a connection-oriented protocol that is used by 
Modbus TCP and EtherNet/IP for explicit messaging.

trap
An event directed by an SNMP agent that indicates one of the following:
 a change has occurred in the status of an agent
 an unauthorized SNMP manager device has attempted to get data from, or change data on, an 

SNMP agent

U
UDP

(user datagram protocol) A transport layer protocol that supports connectionless communications. 
Applications running on networked nodes can use UDP to send datagrams to one another. UDP 
does not always deliver datagrams as reliable or ordered as those delivered by TCP. However, by 
avoiding the overhead required for TCP, UDP is faster. UDP may be the preferred protocol for time-
sensitive applications, where dropped datagrams are preferable to delayed datagrams. UDP is the 
primary transport for implicit messaging in EtherNet/IP.
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Control Expert
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convert Control Expert project

from 7.0 to 8.0, 50

D
derived data types, 77
device DDT

T_Q_DROP_EXT_IN, 75, 83
diagnostics

Modbus codes, 124
system, 120

E
Ethernet link object, 146
Ethernet remote I/O

cabling, 44
Control Expert configuration, 49
diagnostics, 109

EtherNet/IP
explicit messaging, 93
implicit messaging, 107

EtherNet/IP explicit connection diagnostics 
object, 159, 161
EtherNet/IP interface diagnostics object, 150
EtherNet/IP IO Scanner Diagnostics object, 
153
explicit messaging

EtherNet/IP, 98, 100
EtherNet/IP services, 96

F
firmware upgrade
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function code 3

diagnostics, 124
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grounding, 34

I
I/O devices, 24

intelligent, 26
special purpose, 26

identity object, 136
installation, 32, 34
IO connection diagnostics object, 155

L
logging

to Control Expert, 178

M
MAST task, 107
MBP_MSTR, 98
Modbus diagnostic codes, 124
Modicon X80 I/O devices

analog, 25
digital, 25

O
online action

ping, 175
online diagnostics, 170

P
ping, 175

Q
QoS object, 142
Quantum I/O devices

analog, 24
digital, 24
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replacing, 33
rotary switches, 42
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S
setting rotary switches, 42
specifications

140 CRA 312 00, 22
140 CRP 312 00, 22
140 NOC 780 00, 22
140 NOC 781 00, 22
BMX CRA 312 00, 22

T
T_M_DROP_EXT_IN

Modicon X80 remote I/O adapter, 83
T_Q_DROP_EXT_IN

device DDT, 75
Quantum remote I/O adapter, 83

T_U_CRP_HSBY_IN
140 CRP 312 00 Hot Standby), 79

T_U_CRP_STD_IN
140 CRP 312 00 standalone, 79

T_U_DROP_STD_IN
Quantum remote I/O adapter, 83

TCP/IP interface object, 144
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